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INTRODUCTION
1 INTRODUCTION
This manual describes how to use the Planmeca Dimaxis Pro and Dimaxis Classic
imaging software, which is developed to be used with the Planmeca digital imaging
devices and the Intracam intraoral video camera. Some of the functions are available only
in the Dimaxis Pro version. Please read this manual carefully before using the system.

NOTE The digital X-rays and Intracam camera have separate manuals, which should
be used in conjunction with this manual.

NOTE This manual is valid with the following software versions:
Planmeca Dimaxis Pro/Classic 4.2.0
Planmeca Proline software PK 5.08 / PG 5.08 or later (5.13 or later
recommended)
ProMax software 1.05 or later (1.19.1 or later recommended)
Planmeca Intra software 1.20 or later (3.03 or later is needed to use the Intra
control panel of Dimaxis).

NOTE Dimaxis Pro/Classic is used in the Microsoft Windows XP, Windows 2003
Server or Windows 2000 operating system. It is important to learn the
Windows basics before using the Dimaxis Pro/Classic software.

Dimaxis Pro/Classic imaging software fulfills the requirements of Directive 93/42/EEC.

Dimaxis Pro/Classic is an image processing and archival software. The program allows
the user to view, manipulate and archive images, and it can also be used to take images
with all the present and future Planmeca digital imaging devices. Dimaxis Pro/Classic
supports all the basic functionality required to view, manipulate and print images as well as
full support of multiple users on a common image archive that can be located in a network
server.

Special attention has been paid to keep the operation of the Dimaxis Pro/Classic system
as simple as possible. However, it is important to realize that no computer system can be
operated continuously and successfully without competent software and hardware
support. Especially in mission critical applications, like the archival of patient images,
adequate care must be taken, prior to deployment of the system, that the continuous
operation of the system is ensured. This includes, but is not limited to, ensuring that
hardware and software support is available, phone help and user training has been
organized and that the backing up of patient data has been arranged. It is recommended
that a competent system integrator service is engaged for this purpose.

1.1 Brief Introduction to Digital Imaging

Digital imaging differs from film based imaging in two respects:

First of all, digital images are made of small dots called pixels, much like photos in a
newspaper. The size of each pixel sets an absolute upper limit to what can be imaged.
See the table below for the pixel sizes and corresponding theoretical maximum
resolutions. Note that because of the magnification inherent in all projection X-ray
techniques, the theoretical resolution at the object level is slightly higher.

0537
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INTRODUCTION
Secondly, each pixel is represented by a numerical value in the computer memory.
Because of the numerical (nonphysical) nature of the image, the brightness and contrast
of the image can be altered and various image enhancement operations can be performed
which are not normally possible with film images. That is one of the main advantages of
digital imaging, but it is also necessary to understand this and keep it in mind when using
manipulated images for diagnosis. The numerical nature of the image also sets an upper
limit to the detectability of contrast differences (differences in radio translucency) in digital
images. This contrast resolution is expressed in terms of number of bits used in capturing
and storing the image or in number of gray levels that the system can record. See the
table below for values of Planmeca equipment:

Note that although most computer screens can display only 256 (8 bit) or less gray levels
and although it has been shown that the human eye can barely differentiate contrast
differences in the order of 1/32 - 1/64 (5/6 bits), the human eye automatically adapts to the
lightning conditions, and this fact together with proper use of the light box makes it
possible to detect smaller variations in film contrast. Thus it is necessary to capture and
record images at higher contrast resolution than 256 grey levels (8 bits). More contrast
latitude also allows more variations in exposure factors (kV/mA).

IMPORTANT SAFETY NOTICE!
Image processing can significantly alter the visibility of both large and small
structures (i.e. bone loss and caries), which may result in either too many
false positive or false negative findings, if care is not taken.

1.2 Securing the Image Data

The Dimaxis software uses Solid Flow Engine database management software for storing
the image information. Solid Flow Engine database provides a backup function that makes
a backup from the active database. When and how often this backup is made is configured
from the PM Remote Control program. This backup function makes the backup every time
to the same specified location and replaces (overwrites) the old backup. That is why the
end user is responsible to make further safety copies from Solid Flow Engine database
backup directory to ensure the safety of the data. We recommend the end user to keep at
least daily, weekly and monthly backups, stored in a safe place, in order to have enough
security for the data. Note that Planmeca is in no way responsible for the end users’ data
security or for any malfunction in the computer system that leads to data loss.

Device Pixel size Sensor resolution Image resolution

DIMAX2/3 normal 
resolution mode

132 µm 3.8 lp/mm 4.5 lp/mm (5.5*)

DIMAX2/3 enhanced 
resolution mode

99 µm 5.0 lp/mm 6.0 lp/mm (7.3*)

DIMAX2/3 high 
resolution mode (pan)

*Transversal slicing 
mode

66 µm 7.6 lp/mm 9.0 lp/mm (11.0*)

DIXI2/3 normal 
resolution mode

38 µm 13.2 lp/mm 13.2 lp/mm

DIXI2/3 high 
resolution mode

19 µm 26.3 lp/mm  26.3 lp/mm

Device Number of bits Gray levels

DIMAX (all modes) 12 4096
2  Dimaxis Pro/Classic User’s Manual



INTRODUCTION
1.3 Acquisition

The system is designed to automate the acquisition of images with minimum intervention
from the user. Provided that the user has selected the correct patient in the Dimaxis
software the acquisition (taking an exposure) and archiving of the image is almost exactly
the same as with conventional film based imaging systems, except that archiving is fully
automated and no film processing is necessary. The used exposure technique is
automatically stored with the image.

1.4 Settings

Dimaxis provides various settings for the user to choose from. A range of parameters and
other options can be set to permit control over the main procedures. The default settings
have been chosen for a typical Dimaxis environment. If required, they can easily be
changed by selecting the Global Settings, Local Settings or DICOM Settings command
from the Administration pulldown menu. For the settings available, refer to chapter 9
“SETTINGS” on page 127.

In earlier Dimaxis versions all the settings were stored on a local workstation. Since
Dimaxis version 2.4.1 the settings are stored in the database. Most of the settings are
common to all the workstations and all users. Refer to chapter 9 “SETTINGS” on page 127
for more information.

1.5 Archiving

The archiving of images in Dimaxis is organized under patient names. The image data,
exposure technique and basic patient data is stored in a database. Multiple users can
store and retrieve (different) images to and from the database simultaneously. (The basic
price of the system includes a user license that allows only one user at a time, contact
your dealer for the pricing for additional users.)

1.5.1 Disk Space Requirements

The following table gives approximate disk space requirements for different image
formats:

Format Without compression With JPEGa 
compression

DIMAX normal resolution 4.1 MB 1.7 MB

DIMAX enhanced 

resolutionb
7.4 MB 3 MB

DIMAX2/3 normal 
resolution, panoramic

5.0 MB 0.8 MB

DIMAX2/3 normal 
resolution, cephalometric

7.0 MB 0.95 MB

DIMAX2/3 enhanced 

resolutionb, panoramic

8.9 MB 1.1 MB

DIMAX2/3 enhanced 

resolutionb, cephalometric

12.5 MB 1.9 MB
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IMPORTANT SAFETY NOTICE!
JPEG conversion is a so called lossy compression, the use of which can
lead to loss of image detail and it cannot be guaranteed that the diagnostic
value of the compressed image is equivalent to the original image. While
several studies (see e.g. IADMFR/CMI´97 Advances in Maxillofacial Imaging:
The loss of image quality in panoramic radiography using image
compression, C.G.H Sanderink et al.) indicate that the loss of data may be
insignificant, Planmeca cannot guarantee that it is safe to use compressed
image data for diagnostic purposes.

1.6 Long Term Archiving

As more and more images are taken and archived, the archive will gradually fill up to its
maximum capacity after which no more images can be stored. However, most of the
images in any dental practice have a life cycle where, after the initial period of frequent
usage, the image is hardly ever referred to (patient leaves etc.). Therefore, most of the
images in any large archive are not actually used and represent a waste of space. But
because they represent valuable diagnostic data they cannot be removed, in case they
are needed later. Besides, in many states there are laws relating to the storage of images.
For this purpose the Dimaxis software provides the possibility to remove images that have
not been referred to for a certain period of time to a secondary storage, e.g. to a
removable disk. For this purpose it is recommended that the system is equipped with a

DIMAX2/3 high 

resolutionb, panoramic

20 MB 2.2 MB

Dixi A0 200 kB 50 kB

Dixi A1 430 kB 100 kB

Dixi A2 560 kB 140 kB

Dixi2/3 B0 normal 
resolution

560 kB 180 kB

Dixi2/3 B1 normal 
resolution

940 kB 310 kB

Dixi2/3 B2 normal 
resolution

1.3 MB 430 kB

Dixi2 B0 high resolutionb 2.2 MB 720 kB

Dixi2/3 B1 high resolutionb 3.8 MB 1.2 MB

Dixi2/3 B2 high resolutionb 5.2 MB 1.7 MB

a. The actual achievable values depend on the individual image.

b. Because of the extensive disk space requirements and the additional X-ray radiation

needed to achieve the same (low) level of noise (quantum mottle), the user should care-
fully evaluate the advantages of using the enhanced/high resolution mode.

Format Without compression With JPEGa 
compression
4  Dimaxis Pro/Classic User’s Manual
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DVD drive, as this has a large capacity and low cost/storage capacity. The same device
can be used for backing up the archive too, see the note below.

Some of the patient’s images can be in the long term archive (LTA) while other images are
in the active database. New images can also be taken even if some of the images are in
the LTA. Images can be restored at a future date. (Prior to Dimaxis 4.0.0, all the images
had to be either in the LTA or in the active database.)

IMPORTANT SAFETY NOTICE!
Note that the image archive contains valuable and confidential patient data.
Losing this data may compromise patient safety as images may have to be
retaken which will expose the patient to unnecessary radiation dose. To
minimize the risk of losing any data the archive system keeps a log book
into which all (image) data is copied when it is saved into the archive. This
double storage ensures that in case of archive failure (software or hardware)
the archive can be reconstructed with minimum loss of valuable patient
data. In addition to that, regular backing up of the image archive must be
organized by competent personnel. For maximum security so called RAID
systems are preferred for the archive. For backing up the archive refer to the
Solid Flow Engine manuals.

1.7 Study Templates (Optional only in US)

A study is a collection of related images from one patient. It is always based on a study
template. In addition to defining the position of images within the study, the template also
contains information about how to acquire the images: the exposure order, the print
position of images, the orientation of the intraoral sensor in the patient’s mouth, which
teeth are to be imaged on the particular image. This feature makes it possible to acquire
e.g. a full mouth series with the minimum interaction between the computer and the user:
once a proper template has been selected, provided that the user follows the template all
images of the series can be exposed without touching the keyboard/mouse and yet the
proper orientation and image content are recorded with each image.

U.S. Patent No. 5,179,579

1.8 Processing

Note that some of the image processing operations radically alter the appearance and
thus possibly the diagnostic value of the image. However, it is always possible to restore
the image to its original state or undo the modifications one by one.

1.9 Measuring

The measurement tools allow both geometric and relative intensity (i.e. radiotranslucency
or brightness/contrast) measurements to be made.

When performing geometric measurements it should be noted that image processing
operations (even just adjusting the brightness/contrast) can alter the apparent geometry of
the objects in the image. Also because of the normal distortions (most notably varying
magnification) associated with normal projection X-ray imaging the measurements must
be based on known reference objects in the image. For this purpose a calibration tool is
provided in the Dimaxis software.

When performing intensity measurements it should be noted that after certain image
processing operations the relative intensities of the objects may be affected by their
neighboring objects, which may affect the reliability of e.g. bone density measurements
Dimaxis Pro/Classic 5User’s Manual
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with the help of a calibration step wedge. The only image processing operations
guaranteed NOT TO CHANGE the relative intensities so that measurements are
independent of the measurement position, are the brightness/contrast and level
adjustment operations. No guarantee can be given between the intensity measurements
of two different images.

1.10 Annotation

Images can be annotated with markers and text. These annotations appear as an overlay
on the image and can thus be turned on and off at will, they do not affect the actual image.
In addition to the annotations Dimaxis provides the user with the possibility to type in and
store a short commentary (diagnosis) with each image.

1.11 DICOM

DICOM (Digital Imaging and Communications in Medicine) support in Dimaxis has been
implemented using MergeCom-3 toolkit by Merge Technologies Inc. A separate licence
must be purchased to enable DICOM. The DICOM Storage Service Class SCU, the
DICOM Print SCU, the DICOM Modality Worklist SCU, the DICOM Query/Retrieve SCU,
the DICOM Storage Commitment and the DICOM Media Storage have been implemented
into Dimaxis software.
For details about the DICOM compatibility refer to Planmeca’s DICOM Conformance
Statement.

1.12 VDDS

The VDDS Bridge allows integration to most German practice management softwares.
The VDDS Bridge interface application is available on the Planmeca Dimaxis Pro
installation CDs.

1.13 Printing

Dimaxis supports printing to any standard Windows compatible printer. Refer to chapter
9.2.1 “Printer” on page 140 for information on printing from the Microsoft Windows ME
operating system.

Additionally, it is possible to print to a DICOM compatible printer. However, a separate
DICOM licence is required for this. For details about the DICOM compatibility refer to
Planmeca’s DICOM Conformance Statement.

1.14 Date Format

Dimaxis uses the regional display format for dates that has been defined via Control
Panel.
6  Dimaxis Pro/Classic User’s Manual
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1.15 Disclaimer

IMPORTANT SAFETY NOTICE!
Note that Planmeca is in no way responsible for the end user’s data security
or for any malfunction in the computer system that leads to data loss.
Since image processing and digital subtraction radiography can
significantly alter the visibility of both large and small structures (i.e. bone
loss and caries), which may result in either too many false positive or false
negative findings, Planmeca is in no way responsible for the software use,
actions or diagnoses made by the end-user.

1.16 Dimaxis License

From 3.1.0 version on Dimaxis Pro requires a license. If the license has not been installed,
Dimaxis runs in demo mode. See the Dimaxis Installation manual for details.

If the license does not include certain functions such as DICOM, subtraction or Imaging
Plate (CR) scanner those icons are not displayed in the toolbar.
Dimaxis Pro/Classic 7User’s Manual
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2 GETTING STARTED

2.1 Logging In

To start Dimaxis, double-click the Dimaxis icon or select Dimaxis from the Start/Program
menu.

Enter the username and the password to login to the database and click OK.

NOTE The password is “dixi” if it has not been changed by the system
administrator.

2.2 Selecting Patient

You can either select an existing patient or add a new patient to the system.

Dimaxis icon
8  Dimaxis Pro/Classic User’s Manual



GETTING STARTED
Patients can be searched by ID, name, date of birth or Quick-PID, see below for an
explanation.

To search a patient by ID, enter the patient ID to the text field and click OK. To search
patients by their name, enter the patient’s name in Last Name First Name format into the
search field and hit the Enter key or click OK to make matching patients appear in the
patients list.

To view all patients saved in the database use the * sign as the search term.

NOTE If a partial name is entered, Dimaxis will return all patients whose last name
begins with that string. In case you want to search patients by their first name,
replace the last name with the wild card *.

Examples:

The Quick PID patient identifier shortcut consists of the initial letter of the patient’s last
name followed by the last four digits of the patient ID/social security number (e.g.
“R1234”). Refer to section 9.1.1 “Patient” on page 128 for further information.

If the specified patient cannot be found, the message window shown below appears. To
return to the Select Patient window click OK.

Angle Edward All patients with the last name Angle and the first name 
Edward.

J All patients whose last name starts with the letter J.

Joh All patients whose last name starts with ‘Joh’, e.g. Johnes 
and Johansson.

Van Almsick All patients with the last name Van Almsick.

* Anne All patients whose first name is Anne.

19800517 All patients with 17.05.1980 as date of birth and 19800517 
as ID.
Dimaxis Pro/Classic 9User’s Manual



GETTING STARTED
All the patients that fulfil the given selection criteria are shown in the Browse Patients
dialog window. Select the requested patient from the list and click OK.

To add new patient information into the system click the New button in the Select Patient
window or select the New command from the Patient pulldown menu. The New Patient
window will appear. Enter the requested information in the boxes and click OK.

If the automatic patient numbering is selected and you leave the patient ID field empty,
Dimaxis will automatically give the next free patient ID to the new patient. Storing the
patient’s date of birth, checking the social security number and the automatic patient
numbering selection are described in section 9.1.1 “Patient” on page 128.

Select the option Patient is pregnant if the patient was pregnant during exposure. This
information is saved for each image and it is displayed in exposure dialogs and in the X-
Ray Log Book.

In the New Patient window there is a selection list for Doctor, so the user does not have to
type the name of the doctor each time. The selection list will contain previously saved
names.
10  Dimaxis Pro/Classic User’s Manual



GETTING STARTED
It is also possible to write comments in the Comments field.

NOTE The demo license does not allow you to add new patients.

Dimaxis checks that the patient ID does not contain “illegal” characters / , \ , * , ? , ” , < , >
, | , ’ (see the window below).
Using these characters prevents long term archiving and Export All function.

If the patient was successfully inserted into the database the message window shown
below appears.
Dimaxis Pro/Classic 11User’s Manual



GETTING STARTED
2.2.1 Restoring Images from the Long Term Archive

The information in this chapter relates to the long term archiving performed before the
Dimaxis software version 4.0.0. For information on archiving in the Dimaxis 4.0.0 version
refer to section 4.2 “Selecting Image” on page 18.

If the images of the selected patient have been moved to the long term archive the
message window shown below appears. If the long term archive is on a removable media,
like a DVD, insert the media (marked with the archive ID number shown in the message
window) to the drive and click OK to restore the images of the selected patient.

After the patient has been selected it is possible to select an existing image for viewing,
see section 4.2 “Selecting Image” on page 18. To take a new exposure, refer to sections
5.1 “Taking a Cephalometric Exposure” on page 40, 5.2 “Taking a Panoramic Exposure”
on page 46 and 5.3 “Taking an Intraoral Exposure” on page 52. To capture an Intracam
image, see section 5.4 “Capturing Intracam Images” on page 57.
12  Dimaxis Pro/Classic User’s Manual
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3 TOOLBARS

NOTE The toolbar contents vary depending on whether patient is selected and
images are opened or not.

3.1 Toolbar with no Patient Selected

The button for patient selection is located on the toolbar at the top. The same function can
also be chosen from the Patient pulldown menu.

3.2 Toolbar with no Images Open for the Selected Patient

The buttons for patient selection and image viewing and exposing are located on the
toolbar at the top. The same functions can also be chosen from the pulldown menus.
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3.3 Toolbars with Image(s) Open for the Selected Patient

The buttons for patient selection, image viewing, exposing and printing as well as image
processing are located on the toolbars at the top and on the right side of the open image
(see next page). The same functions can also be chosen from the pulldown menus (see 8
“PULLDOWN MENUS” on page 83).

Some of the buttons can be chosen not to be shown on the toolbars. Refer to section 9.2.7
“Icons (Pro Version only)” on page 150 for further information.
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3.3.1 Upper Toolbar

 

Select Patient

Select Image

Select by Tooth Range

 

DICOM Modality Worklist
Zoom Out Mode

Toggle Measurement Toolbar

Toggle Rotating Toolbar

Toggle Viewing Toolbar

DICOM Storage (Pro version only)

Diagnose

Edit Intracam image
Intracam

DICOM Print (Pro version only)

Cephalometric Exposure

Panoramic Exposure

Intraoral Exposure

TWAIN Acquire

Export
Print the active image

Image Navigator

Zoom In Mode (+ Alt = Zoom Out)

Decision Support (Pro version only)Image Plate (CR) Scanner
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3.3.2 Right Toolbar

Adjust Levels

Brightness Control

Subtract

Region of Interest (ROI)

Toggle Image Processing Toolbar

Contrast/Brightness

Invert

Contrast Control

Control Points for Subtraction

Pseudo Colors

Undo

Redo
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4 IMAGE FINDING AND VIEWING
The archiving of images in Dimaxis is organized under patient names, i.e. the patient must
first be selected. The images are stored according to 1) exposure type and 2) exposure
date (latest first). The image(s) and study of the patient can be selected for viewing in the
Select Image window, refer to section 4.2 “Selecting Image” on page 18. The intraoral
images can also be selected by using a tooth range selection or an image navigator, refer
to sections 4.3 “Selecting by Tooth Range” on page 37 and 4.4 “Image Navigator” on page
38.

4.1 Selecting Patient

Click the Select Patient button located on the upper toolbar or select the Select command
from the Patient pulldown menu and the Select Patient window appears. Refer to section
2.2 “Selecting Patient” on page 8 for a detailed description of the patient selection
functions.

Select Patient
button
Dimaxis Pro/Classic 17User’s Manual



IMAGE FINDING AND VIEWING
4.2 Selecting Image

Click the Select Image button located on the upper toolbar or select the Select command
from the Image pulldown menu and the Select Image window appears. Select the image
type or study window from the tabbed panes at the top of the window.

It is possible to select images under the different tabbed panes and then by clicking OK to
open all the selected images at the same time.

Select
Image
button
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From Dimaxis version 4.0.0 on, a single image can be in the long term archive (LTA). If
this is the case, an image preview with the note In Long Term Archive or a grey rectangle
is displayed (see 10 “MOVING IMAGES TO LONG TERM ARCHIVE” on page 160). Some
of the patient’s images can be in the LTA, while other images are in the active database.
Earlier all the images had to be either in the LTA or in the active database. New images
can also be taken even if some of the images are in the LTA.

The images can be restored, provided that this computer has access to the long term
archive. By selecting the requested image and pressing OK or double clicking the image, a
dialog box opens. If the image should be restored, press Yes.

If more than one image should be restored, select the images by holding down Ctrl and
pressing the OK button.
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4.2.1 Select Image/Study (Optional only in US)

In the Study window the used studies of the selected patient are listed. You can open or
delete an existing study or add a new study.

4.2.2 Adding a New Study

To add a new study click the New Study button. The Select a Study Template window
appears. Select a template and click OK.
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The Notes for the Study window appears. Fill in a comment and accession number and
click OK, or return to the Select Image/Study window without adding a study by clicking
Cancel. The Accession Number field is only relevant if the study is to be sent to a DICOM
application. The Study Instance UID (Unique Identifier for the Study) only has a value if the
current patient has been selected from a DICOM Modality Worklist.

4.2.3 Deleting a Study

To delete a study select a study and click the Delete Study button. The message window
shown below appears. Click Yes to delete the study, or return to the Select Image window
by clicking No.

If the study you try to delete contains images, the message window shown below appears.
Click OK. Remove the images from the study as described in section4.2.4 “Opening a
Study” on page 22 and then delete the study.
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4.2.4 Opening a Study

To open a study select the desired study and click OK in the Select Image/Study window
or open the study by double-clicking the desired study. The Study window appears. Click
an image to select it. Several images can be selected by holding down the Ctrl or Shift
key and then clicking the left mouse button, or by just right-clicking. The exposure
parameters of the selected image are shown at the top of the Study window.

If no images have been selected in the Study window and you click one of the buttons at
the bottom of the window, most of the functions will be applied to all images.

Exposing an Image

You can expose an image by clicking one of the Expose Image buttons. Note that the next
available selected type of image in the study will be exposed, if you have not selected an
image before clicking the button.
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Image Plate (CR) Scanner

To scan an image, refer to section 5.6 “Image Plate (CR) Scanner (Pro version only)” on
page 61.

Detach

You can detach an image from the study by clicking the Detach button in the Study
window. Note that the image will not be removed from the database. If you want to
remove the image from the database, open the image and select the Delete command
from the Image pulldown menu.

If you want to detach the image from the study, click Yes. By clicking No you will return to
the Study window.

DICOM Storage (Pro Version only)

You can send the images of the study to a DICOM application by clicking the D/Storage
button.

Image Plate (CR) Scanner
button

Detach button

DICOM/Storage button
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The Send Study to DICOM AE window appears.

While sending the images of the study, network specific errors may occur. If you want to
retry sending images after such an error, select Continue On Error.

If you want to send only some of the study images, select the images before opening this
dialog and select Send Selected Images Only.

The images stored in the Dimaxis database are numbered in acquisition order. If you want
to replace these numbers with Send order numbers, select Use Send Order Numbers as
Image Numbers. Note that this selection is disabled if you have not changed the send
order, refer to section 11.1.7 “Changing DICOM Send Order” on page 173.

If you want to send only the images that have not yet been sent to DICOM application,
select Send Previously Unsent Images Only.

After the images have been successfully sent the message window shown below appears.

If sending of the images failed, check that the receiving DICOM application is up and
running and that the network is working properly. Retry sending. If it still does not succeed,
open the Log file by clicking the Log File button, print the file and fax or send it to your local
support.

Log file button
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DICOM Print (Pro Version only)

You can print the images of the study with a DICOM compatible printer by clicking the D/
Print button.

The DICOM Print Study window appears.

If you want to print only some of the study images, select the images before opening this
dialog and select Print Selected Images Only.

Session Label identifies the film session. This field can be left blank if the print jobs are not
mon-itored by some other system.

Select the Number of Copies and print the images by clicking OK.

Refer to section 7 “DICOM” on page 70 for more information about DICOM print.

DICOM/Print button
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Parameters

When a cephalometric image is selected, the image parameters are shown in the
Cephalometric Image Parameters window that appears when you click the Parameters
button.

In this window you can enter the user name and a comment. You can also change the
exposure date, if the computer date setting was not correct when the image was exposed.

Parameters button
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When a panoramic image is selected, the image parameters are shown in the Panoramic
Image Parameters window that appears when you click the Parameters button. In this
window you can enter the user name and a comment. You can also change the exposure
date, if the computer date setting was not correct when the image was exposed.
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When an intraoral image is selected, the image parameters are shown in the Intraoral
Image Parameters window that appears when you click the Parameters button. In this
window you can enter the user name and a comment, change the tooth range, change the
sensor orientation, fill in exposure parameters, change the exposure date (if the computer
date setting was not correct), and specify the offset to the middle of the leftmost tooth
(patient’s rightmost) on the image with the offset arrows in the lower left corner of the
window. The offset is utilized in the Image Navigator function, refer to section 4.4 Image
Navigator on page 38.4.4 “Image Navigator” on page 38. 
28  Dimaxis Pro/Classic User’s Manual



IMAGE FINDING AND VIEWING
Select All

You can process several images at the same time by clicking the Select All button in the
Study window.

Open

Open the selected image(s) by clicking the Open button in the Study window. If no images
have been selected, all the images in the study will be opened.

Paste

You can insert existing images to a study by opening the image and selecting Copy (or
Ctrl+C) from the Edit pulldown menu, selecting the image placeholder and clicking Paste
(or Ctrl+V).

Preview

You can get a print preview of the selected images of the study by clicking the Preview
button.

Print

The print positions of the images are selected when creating/modifying study templates,
see section 11.1.1 “Adding Image Placeholders” on page 168. The predetermined print
position is indicated with row/column numbers at the lower right corner of the image. Note
that the selected print order is used only if the print position has been specified for all the
images to be printed.

Select All button

Open button

Preview button
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The images of a study will be printed in exposure order if the print positions of the images
have not been determined.

If all the images have been taken during the same day the exposure date will be printed on
the footer text.

If the license text is exactly the same string as the name of the doctor, the license text will
not be printed. If the license text is printed, it is printed above the user configured footer
text (the footer text is often the address of the clinic).

Refer to section 6 “PRINTING THE IMAGES” on page 67 for more information about
printing the images.

Click the Print button in the Study window.

The Print window appears.

If you want to print only some of the study images, select the images before clicking the
Print button and make sure that the print range is set to Selection.

Select the Number of copies and print the images by clicking OK.

Export

By clicking the Export button a window shown below appears where you can define the
export parameters.
If no images have been selected, all the images in the study will be exported.

The Export command exports images as a single image into separate files.

Print button

Export button
30  Dimaxis Pro/Classic User’s Manual



IMAGE FINDING AND VIEWING
Export Study View as an Image

By clicking the Exp. View button a window shown below appears.
If no images have been selected, all the images in the study will be exported.

The Exp. View command exports a whole view into one single file.

Export View button
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Comment

You can modify the comment of the study which is shown in the Study window. Click the
Comment button and the Notes for the Study window appears.

Fill in the comment text (and accession number) and click OK.

Comment button
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4.2.5 Select Image/Panoramic

In the Panoramic window the panoramic images of the selected patient are shown. Click
the desired image once to select it. The image is deselected when you click another
image. Several images can be selected by holding down the Ctrl or Shift key and then
clicking the images. The selected images are indicated with a grey border. Click OK to
open the selected image(s). You can also open an image by double-clicking it.

The parameters of the selected image are shown in the window that appears when you
click the Parameters button.
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4.2.6 Select Image/Cephalometric

In the Cephalometric window the cephalometric images of the selected patient are
shown. Click the desired image once to select it. The image is deselected when you click
another image. Several images can be selected by holding down the Ctrl or Shift key and
then clicking the images. The selected images are indicated with a grey border. Click OK
to open the selected image(s). You can also open an image by double-clicking it.

The parameters of the selected image are shown in the window that appears when you
click the Parameters button.
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4.2.7 Select Image/Intraoral

In the Intraoral window the intraoral images of the selected patient are shown. Click the
desired image once to select it. The image is deselected when you click another image.
Several images can be selected by holding down the Ctrl or Shift key and then clicking
the images. The selected images are indicated with a grey border. Click OK to open the
selected image(s). You can also open an image by double-clicking it.

The parameters of the selected image are shown in the window that appears when you
click the Parameters button.
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4.2.8 Select Image/Intracam

In the Intracam window the Intracam images of the selected patient are shown. Click the
desired image once to select it. The image is deselected when you click another image.
Several images can be selected by holding down the Ctrl or Shift key and then clicking
the images. The selected images are indicated with a grey border. Click OK to open the
selected image(s). You can also open an image by double-clicking it.
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4.3 Selecting by Tooth Range

The intraoral images of the patient can be selected by using a tooth navigator. The tooth
identification system can be selected in the Global Settings/Intraoral window, refer to
section 9.1.6 “Intraoral” on page 135. In the FDI/ISO system teeth are designated by a two
digit code. The first digit indicates the quadrant and the second digit indicates the tooth. In
the ADA system teeth are designated by consecutive numbers.

Click the Select by Tooth Range button located on the upper toolbar or select the Select
by Tooth Range command from the Image pulldown menu and the Tooth Range window
appears.

Select the desired teeth by clicking the teeth pictures in the Tooth Range window. The
selected teeth are marked with blue colour. The number above the tooth indicates the
number of images containing that tooth.

FDI/ISO system

Select by
Tooth Range
button

Number of images containing this tooth

Tooth number

ADA system
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Click OK and the Select Image/Intraoral window with only the image(s) of the selected
teeth appears.

4.4 Image Navigator

The panoramic, cephalometric, intraoral and Intracam images of the patient can be
selected by using the Image Navigator. The tooth identification system is selected in the
Global Settings/Intraoral window, refer to section 9.1.6 “Intraoral” on page 135. In the
FDI/ISO system teeth are designated by a two digit code. The first digit indicates the
quadrant and the second digit indicates the tooth. In the ADA system teeth are designated
by consecutive numbers.

Click the Image Navigator button located on the upper toolbar or select the Image
Navigator command from the Image pulldown menu and the Image Navigator window
appears. The image positions of the intraoral images on the right of the window are
adjusted either in the Intraoral Exposure window or in the Intraoral Image Parameters
window with the offset to the leftmost tooth arrows in the lower left corner of the window.
With the offset arrows you can indicate the position that is in line with the number of the
leftmost tooth in the Image Navigator window. This function enables you to get a better
overview of the available images.

It is recommended to use the default background colour violet in the Image Navigator
window. The background colour is selected in the Global Settings/Window window, refer
to section 9.1.3 “Window” on page 132.

Select the images to be shown in the Image Navigator window from the list located in the
upper right corner of the window: From All Dates shows all the intraoral images of the
patient and the images of a full mouth set are shown when you select the date.

Select the images to be shown from the list located on the right of the window: Photos
shows the Intracam images, Panoramics shows the panoramic images, Cephs shows the
cephalometric images and Intraorals shows the intraoral images.

Image Navigator

Intracam images Panoramic images Cephalometric images Intraoral images

Hide the left side of the window

Zoom the selected image

Zoom the selected image(s) in full screen

Open the selected image(s)

button
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Select Periapicals, Bitewings or Both from the list located in the lower right corner of the
window depending if you want to see images of the upper and lower jaws, the bitewings or
both of them.

Select the desired teeth by clicking the teeth numbers in the Image Navigator window on
the right of the window. The selected teeth are marked with green colour and the image(s)
of the selected teeth are shown on the left of the window. The number above or below the
tooth number indicates the number of the images containing that tooth. The images of the
upper jaw are shown above the teeth numbers and the images of the lower jaw below the
numbers.

For a new image selection click the Reselect button on the right of the window.

Hide the left pane by clicking . If you do not select any image type on the right side of
the window (Photos, Panoramics, Cephs or Intraorals) the left pane stays hidden, as well.

Click the image you want to zoom in and then click the Zoom in button . If you click the
Zoom in button before clicking the image you want to zoom, the message window shown
below appears. Click OK and select the image for zooming first.

Click the image(s) you want to zoom in and then click the Full screen zoom button . If
you click the Full screen zoom button before clicking the image(s) you want to zoom, the
message window shown above appears. Click OK and select the image(s) for zooming
first. Close the full screen zoom window by clicking Close.

Click the image(s) you want to open and then click the Open selected image(s) button .
If you click the Open the selected image(s) button before clicking the image(s) you want to
zoom, the message window shown above appears. Click OK and select the image(s) for
opening first.

Double-click the images on the left of the window to open them. Close the Image
Navigator window by clicking again the Image Navigator button on the upper toolbar, by
selecting the Image Navigator command again from the Image pulldown menu or by
clicking the Close button in the bottom right of the Image Navigator window.
Dimaxis Pro/Classic 39User’s Manual



IMAGE ACQUISITION
5 IMAGE ACQUISITION

5.1 Taking a Cephalometric Exposure

Select the patient as described in section 2.2 “Selecting Patient” on page 8.

Click the Cephalometric Exposure button, or in the Select Image window select the
Cephalometric tab.

In the Select Image window, click the New button.

The Cephalometric Exposure window with the message Waiting for Ready appears (see
the next page). Prepare the patient for the exposure, drive the cephalostat to the ready
position and select the exposure parameters. Refer to the Dimax3 user’s manual.

 Cephalometric Exposure
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In the Cephalometric Exposure window you can select the User from the user selection
list (see below).
The user selection list can be used also in the Panoramic Exposure and Intraoral
Exposure windows (refer to sections 5.2 “Taking a Panoramic Exposure” on page 46 and
5.3 “Taking an Intraoral Exposure” on page 52). 
Dimaxis Pro/Classic 41User’s Manual



IMAGE ACQUISITION
When the cephalostat is in the ready position the following message appears. You can
now take the exposure.

If you want to interrupt the exposure process after the Cephalometric Exposure window
has appeared on the screen, press the ESC key. The message window shown below
appears. If you do not want to interrupt the process, click No.

In section 9.1.4 “Panoramic” on page 133 it is possible to determine that it is not possible
to reject images during the exposure. In that case the Cancel button in the Cephalometric
Exposure window is not visible.
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When you click Yes, you can close the Cephalometric Exposure window by clicking the
Cancel button. The message window shown below appears. Click Yes to close the
Cephalometric Exposure window, or return to the window by clicking No.

After the exposure has been taken, the image is shown in the Cephalometric Exposure
window. Below the information lines, the Exposure Level can be seen in the colored bar.
This graphical exposure quality indicator (EQN-Exposure Quality Normalized) provides
an indication about the irradiance of the exposure. If there is too much radiation, it will be
shown in the orange or red region of the Exposure Level bar. If there is too little radiation,
it is displayed in the blue region. The EQN Value field states the specific value. The low
and high values for all devices can be set in 9.1 “Global Settings” on page 128. Fill in the
required information and accept the image by clicking OK. 

Note that only approved images will be stored in the database.
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The parameters of the exposure are shown in the Cephalometric Image Parameters
window that appears when you click the Parameters button in the Select Image window.

The Image Parameters window can also be opened by selecting the Image Parameters
command from the View pulldown menu that is visible when an image is open. The
dialogs are different depending on whether the image has been taken or imported (see
also next page).

Parameters button
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5.2 Taking a Panoramic Exposure

Select the patient as described in section 2.2 “Selecting Patient” on page 8.

Click the Panoramic Exposure button, or in the Select Image window select the
Panoramic tab.

In the Select Image window, click the New button.

 Panoramic Exposure
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The Panoramic Exposure window with the message Waiting for Ready appears. Prepare
the patient for the exposure, select the exposure parameters and drive the X-ray unit to
the ready position. Refer to the panoramic X-ray unit’s user’s manual. 
Dimaxis Pro/Classic 47User’s Manual



IMAGE ACQUISITION
When the panoramic unit is in the ready position the following message appears. You can
now take the exposure. 

If you want to interrupt the exposure process after the Panoramic Exposure window has
appeared on the screen, press the ESC key. The message window shown below appears.
If you do not want to interrupt the process, click No.

When you click Yes, you can close the Panoramic Exposure window by clicking the
Cancel button. The message window shown below appears. Click Yes to close the
Panoramic Exposure window, or return to the window by clicking No.
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After the exposure has been taken the image is shown in the Panoramic Exposure
window. Below the information lines, the Exposure Level can be seen in the colored bar.
This graphical exposure quality indicator (EQN-Exposure Quality Normalized) provides
an indication about the irradiance of the exposure. Too much radiation will be shown in the
orange or red region of the Exposure Level bar, however too little radiation is displayed in
the blue region. The EQN Value field states the specific value. The low and high values for
all devices can be set in Global Settings, see 9.1 “Global Settings” on page 128. Fill in the
required information and accept the image by clicking OK. Note that only approved
images will be stored in the database.

NOTE Note that if you have used one of the special programs of the panoramic unit
(Double TMJ, True profile TMJ, Transversal slicing system), you may be able
to take more than one exposure in one image. Between the exposures the
Waiting for Ready and Waiting for Exposure messages will be shown.

The parameters of the exposure are shown in the Panoramic Image Parameters window
that appears when you click the Parameters button in the Select Image window.

Parameters button
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The Image Parameters window can also be opened by selecting the Image Parameters
command from the View pulldown menu that is visible when an image is open. The
dialogs are different depending on whether the image has been taken or imported (see
also next page).
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5.3 Taking an Intraoral Exposure

Select the patient as described in section 2.2 “Selecting Patient” on page 8.

Click the Intraoral Exposure button located on the upper toolbar.

You can determine if you want to use studies in intraoral exposures. Refer to 9.1.7 “Study
(Optional only in the US)” on page 137.

The Select a Study window appears (Optional in US). You can either open a new study or
continue with a partially filled study. Select the desired study and click OK.

NOTE To take an intraoral exposure without using a study template, click the No
Template button in the Select a Study window.

Intraoral Exposure
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You can also take a single intraoral exposure without using a study template by selecting
the Intraoral tab in the Select Image window and clicking the New button.

It is possible to take a single intraoral exposure without using a study template also by
inactivating the option Use studies in intraoral exposures in the Global Settings window
(see 9.1.7 “Study (Optional only in the US)” on page 137).

If you expose a new image by choosing the type of exposure from the pulldown menu or
by clicking the specific icon on the upper toolbar, and if you have selected the option
Image Navigator as a default image selection method in the Global Settings window (see
9.1.2 “Image” on page 129), the Image Navigator window will be opened after taking the
exposure.
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The Intraoral Exposure window appears. When the X-ray is in the ready state the
message Waiting for Exposure appears in the lower right corner of the window. Prepare
the patient for the exposure and select the exposure parameters, refer to the Planmeca
Intra X-ray unit’s user’s manual. You can now take the exposure.

In the Intraoral Exposure window the Planmeca Intra X-ray settings can be controlled
through the Intra control panel. The exposure parameters can be set in this window if you
are using the Planmeca Intra with updated software 3.0.3. The control panel logic is
identical to that of the Planmeca Intra remote control.

The functionality of the Intra control panel requires that the synchronization cable for the
Intra is connected.
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After the exposure the message Saving the image appears in the lower right corner of the
window indicating that the image is automatically stored in the database.

Below the information lines, the Exposure Level can be seen in the colored bar. This
graphical exposure quality indicator (EQN-Exposure Quality Normalized) provides an
indication about the irradiance of the exposure. If there is too much radiation, it will be
shown in the orange or red region of the Exposure Level bar. If there is too little radiation,
it is displayed in the blue region. The EQN Value field states the specific value. The low
and high values for all devices can be set in the 9.1 “Global Settings” on page 128.
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When using a study template the Waiting for Exposure message appears again and the
next exposure can be taken.

When using a study template the Intraoral Exposure window shows the previous image
during the exposure procedure so that the user sees if the image has to be taken a second
time. It is possible to change the following parameters of the previous image: sensor
orientation and offset to the middle of the leftmost tooth (patient’s rightmost) on the image.
The offset is utilized in the Image Navigator, refer to section 4.4 “Image Navigator” on
page 38.

NOTE If you have continued with an old, partially filled study, the parameters of the
image taken in the previous exposure procedure cannot be changed in this
window.

After the required image(s) have been taken, click Done.

If you used a study template, the Study window appears. Click the desired image and OK
to open an image. If you want to open more than one image, press the Shift key when
clicking the images. For information on the Study window, see section 4.2 “Selecting
Image” on page 18.

Tooth number of the leftmost tooth

Offset to the middle of the leftmost tooth on the image
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NOTE You can stop the exposure procedure before all images have been taken and
complete the study later.

If you took a single intraoral exposure without using a study template, you can view the
parameters of the exposure by clicking the Parameters button in the Select Image
window. The Intraoral Image Parameters window can also be opened by selecting the
Image Parameters command from the View pulldown menu that is visible when an image
is open.

5.4 Capturing Intracam Images

Select the patient as described in section 2.2 “Selecting Patient” on page 8.

The Intracam Image Capture window will be opened automatically when you activate the
Intracam camera and the window will be closed when you put the camera back into its
place. The function utilizes the serial port interface of the Planmeca Compact for
transmitting camera information. If there is any modal window open in the Dimaxis
software (e.g. Select Image window) it is not possible to activate the function
automatically.

Activate the Intracam camera and click the Intracam button located on the upper toolbar or
select the Intracam command from the Capture pulldown menu.

If the driver for the video card is not properly installed, the message window shown below
appears. Click OK. Install the driver for the video card again.

Intracam
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The Intracam Image Capture window appears. The Intracam image is shown in the big
window. The image can be frozen with the Freeze button and saved with the Save button.
Unfreeze the image with the Resume button. The saved images are shown in thumbnail
size on the right side of the big window.

NOTE The images will be saved to the database only if you have selected the option
“Save the still images permanently to the database” at the top of the window.
Otherwise the Intracam images will be saved only temporarily, and they will
be removed when you close the image window.

NOTE The images can also be frozen and saved with the Planmeca Compact dental
unit’s foot control. Refer to the Intracam intraoral video camera user’s
manual.
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5.5 TWAIN Interface

TWAIN is a cross-platform interface for acquiring images captured by scanners, digital
cameras or frame grabbers. The manufacturer of the TWAIN device must provide a
Source Manager and TWAIN Data source for your device to work with Dimaxis.

Dimaxis supports the current TWAIN_32 standard. Refer to your device manufacturer’s
documentation for information on the availability of TWAIN_32 source modules.

5.5.1 Acquiring an Image Using the TWAIN Interface

Select the patient as described in section 2.2 “Selecting Patient” on page 8.

If you are using the TWAIN device for the first time, select the TWAIN Select Source
command from the Capture pulldown menu.

The Select Source window appears. Select the device you are using and click the Select
button. The sources appearing on the list depend on the TWAIN compatible devices
installed in the PC.

NOTE This window is also used to switch devices, if more than one TWAIN device is
installed in the system.
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To acquire an image, either click the TWAIN Acquire button on the upper toolbar or select
the TWAIN Acquire command from the Capture pulldown menu. Refer to the scanner/
camera user’s manual for information on how to proceed with the device you are using.

Use the TWAIN Setup command on the Capture pulldown menu to check or change the
settings for the scanner/camera. It the TWAIN source can not be opened, the source has
not been selected or there is no TWAIN compatible device available.

TWAIN Acquire
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5.6 Image Plate (CR) Scanner (Pro version only)

Dimaxis can capture images using CombiX and VistaScan imaging plate scanners.

NOTE Refer to the scanner user’s manual for more information about scanning
images.

NOTE This function must be licensed separately.

5.6.1 CombiX Scanner (USB)

Select the patient as described in section 2.2 “Selecting Patient” on page 8.

Click the Image Plate (CR) Scanner button on the upper toolbar or select the Image Plate
(CR) Scanner command from the Capture pulldown menu to scan an image. The window
shown below appears. Prepare the scanner according to the instructions given in the
scanner user’s manual.

If necessary, select the image plate holder type from the Holders list. Click the Scan button
to start scanning. The image will appear in the window. If you want to interrupt scanning
click the Abort button. To erase the image traces from the imaging plates, click the Erase
button. Use the Setup button to check or change the settings for the scanner (refer to
scanner user’s manual).

NOTE Do not change the image format specific settings.

Image Plate (CR) Scanner
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5.6.2 VistaScan

Select the patient as described in section 2.2 “Selecting Patient” on page 8.

Select the option VistaScan in the CR Scanner window in the Local And User Specific
Settings window in the Dimaxis. This selection has to be done only once.
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The scanning preview window appears.

In the scanning preview window you can select the image format from the pulldown menu
(see below).
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After the image has been scanned the preview window shown below appears.
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In the Image Parameters window you can give a comment and determine the Tooth
Range and the image parameters.
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The scanned image is shown in Dimaxis.
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6 PRINTING THE IMAGES

6.1 Printing Single Images

Open the image and click the Print button, select the Print command from the Image
pulldown menu or select Ctrl+P.

Note that you can see the print preview of the image by selecting the Print Preview
command from the Image pulldown menu.

For details about the scale/size of the printed image on a page see sections 6.3 “Printing
X-Ray Images” on page 68 and 6.4 “Printing Intracam Images” on page 68.

Print button
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6.2 Printing Multiple Images (on Same Page)

To be able to print multiple images on the same page the images to be printed must be in
a single study. To print all the images in a study, open the study and click the Print button.
To print only some of the images first select the images to be printed and then click the
Print button. Refer to section 4.2.1 “Select Image/Study (Optional only in US)” on page 20
for more information about printing images from a study.

Multiple images are printed on the same page in a rectangular grid format. For each image
the study template defines in which grid cell the image will be printed in. The size of the
grid (number of rows and columns) is defined by the smallest grid size that can be used to
print the images in the selected format (row/column) positions. Note that if the print
positions for all of the images to be printed are not specified, the images will be printed in
the order in which they were exposed.

To set the printing positions see section 11.1.8 “Changing Image Placeholder Parameters”
on page 173.

Scale, Quality and Printed Area of Printed Images

The size and scale of images on paper or film depend on many factors such as the image
type, the printer used and whether the image is being printed as part of a study or not. For
a detailed description see sections 6.3 “Printing X-Ray Images” on page 68 and 6.4
“Printing Intracam Images” on page 68.

NOTE Because of the varying image scaling, it is the user’s responsibility to ensure
the scale of the printed images before making any measurements from the
printed hard copy. When making measurements on the printed image it is
recommended that a known reference object is used to determine the scale,
e.g. a ball phantom or scale exposed on the image.

NOTE Depending on the printer, image printing very often results in a loss of image
resolution and detail because of the limited resolution of the printer. To
ensure that the image quality of the printed image is sufficient, a test
exposure of a phantom with both realistic objects (i.e. teeth) and resolution
patterns should be made, and the printed image should then be compared
with the image on the screen.

6.3 Printing X-Ray Images

When images are printed the scaling is determined by the print scale setting of the X-ray
images. For changing the setting see section 9.2.1 “Printer” on page 140. A scale of 100%
means that the image will be printed so that the size of the printed image is equal to the
real active sensor area. A 200% scale will make the printed images twice that size and
50% will print the images at half that size. Note that if the image does not fit the usable
print area it will be scaled down to make it fit. This means that with a scale factor of 100%
images are printed in the actual size. Thus if the projection of the image’s magnification
(which is usually negligible) is known it is possible to make direct measurements on the
printed image, assuming that the printer page size is large enough to allow printing in this
size.

6.4 Printing Intracam Images

When intraoral video images are printed the scaling is determined by the print scale
setting of intraoral video images. For changing the setting see section 9.2.1 “Printer” on
page 140. A scale of 100% means that the image will be scaled so that an average of
three images will fit side by side on a printed A4 size page. A 200% scale will make the
printed images twice that size and 50% will print the images at half that size. Note that if
the image does not fit the usable print area it will be scaled down to make it fit. The actual
image scale depends on the image grabber used and is in any case not of much
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importance because the magnification of intraoral video images depends on the distance
from the camera to the tooth and thus varies widely from image to image.

6.5 Print All (Pro Version only)

Select the Print All command from the Image pulldown menu to print all opened images
the way they are shown on the display. You can have several copies of the same image
open at the same time, with different modifications.

If a region of interest is selected on the opened image, only the selected region will be
printed.

If all the images have been taken during the same day the exposure date will be printed on
the footer text.

The preview is always shown before printing (see below). The images can be dragged
(repositioned) using the mouse in the preview display.

You can select the output format of the printed images: Symmetric grid, Images per row or
Images per column. If necessary, select the Number of copies and print the images by
clicking OK.
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7 DICOM

7.1 DICOM Print (Pro Version only)

You can print the opened image with a DICOM compatible printer by clicking the DICOM
Print button on the upper toolbar or selecting the DICOM Print command from the DICOM
pulldown menu.

The DICOM Print window appears. Select the number of copies and print the image by
clicking OK.

Session Label identifies the film session. This field can be left blank if the print jobs are not
monitored by some other system.

You can select the default DICOM printer by clicking the Select button. The Select
Remote DICOM AE window appears. Select the printer application and click OK.

DICOM Print button
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The DICOM Printer Setup window appears when you click the Setup button. In this
window you can define the DICOM Standard specific parameters in the Film Session and
Film Box groups. Film Orientation (portrait/landscape) is a commonly changed field.

By specifying the image sizes you can affect the scaling of the printed images.

In the Print Level group you can select the print level. You can choose either Film Session
or Film Box depending on the DICOM printer you are using (see the printer’s DICOM
Conformance Statement for more information).

In the Other Properties group you can select or deselect support for print jobs, or define
that only 8 bit images will be printed. In this case the images will be mapped to 8 bits
before they are sent to the printer.

NOTE See the printer’s DICOM Conformance Statement for information about the
printer’s capabilities.
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The DICOM Printer Info window appears when you click the Status button in the DICOM
Print window.

7.2 DICOM Storage (Pro Version only)

The DICOM Storage button is located on the upper toolbar. You can send the selected
image to a remote DICOM application by clicking this button or selecting the DICOM
Storage command from the DICOM pulldown menu.

The Send Image to DICOM AE window appears. Fill in the DICOM specific fields: Study
ID etc. if the receiving application requires them. Click OK.

DICOM Storage button
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If sending the image failed, the message window shown below appears. Check that the
receiving DICOM application is up and running and that the network is working properly.
Retry sending. If this still does not succeed, open the Log file by clicking the Log File
button in the Send Image to DICOM AE window, print the file and fax or send it to your
local support.

After the image has been successfully sent the message window shown below appears.

You can select the target DICOM application by clicking the Select button. The Select
Remote DICOM AE window appears. Select the application and click OK.
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The DICOM Storage Setup window appears when you click the Setup button. For more
information refer to section 9.3.1 “Applications” on page 155.

7.3 DICOM Pulldown Menu (no Images Open) (Pro Version only)

This DICOM pulldown menu is visible when no images are open.
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7.3.1 Read DICOM Media (Pro Version only)

A DICOM Media contains a special file DICOMDIR and one or more DICOM image files.
See the DICOM Standard for details.

If the option Show Image Parameters Window is not selected in the Read DICOM Media
window, the parameters dialog for new images will not be shown.

7.3.2 Import DICOM Image File

It is also possible to import one DICOM image file withouth a DICOMDIR file. The standard
presumes a DICOMDIR, but some other programs do not produce it.

7.3.3 Modality Worklist (Pro Version only)

A Worklist is the structure to present information related to a particular set of tasks. It
specifies par-ticular details for each task. The information may support the selection of the
task to be performed first and may support the performance of that task. See the DICOM
Standard for details.

It is also possible to use the Worklist function, though the DICOM support has not been
installed into the workstation. In that case the worklist entries will be retrieved from the
Dimaxis database. In this case the DICOM Gateway must be running in another computer
in the network.
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If it was not possible to get the worklist, the message window shown below appears.
Check that the management software is up and running and that the network is working
properly. Retry. If this still does not succeed, open the Log file by clicking the Log File
button, print the file and fax it or send it to your local support.

Requesting a worklist from the management system can take quite a long time. Therefore,
when the worklist is retrieved for the first time in a day, a copy of the worklist is saved in
the Dimaxis database. After that the local worklist is used.
Click Refresh to update the list from the server.

7.3.4 Today’s Worklist (Pro Version only)

Select the Today’s Worklist command from the DICOM pulldown menu to see the
Worklist with the patients scheduled for today.

If there is only one entry on the database this patient is selected automatically.
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7.3.5 DICOM Long Term Archiving (Pro Version only)

This function is similar to the Move to Long Term Archive function, but instead of moving
the images to a removable media or to a local disc the images are moved into the DICOM
archiving system. The images can be retrieved back from the DICOM archive to the
Dimaxis database by using the Query/Retrieve function.

For details about the Move to Long Term Archive function see section 10 “MOVING
IMAGES TO LONG TERM ARCHIVE” on page 160 and for details about the Query/
Retrieve function see section 7.3.6 “Query/Retrieve (Pro Version only)” on page 78.

Some of the patient’s images can be in the long term archive (LTA) while other images are
in the active database. New images can also be taken even if some of the images are in
the LTA. Images can be restored one at a time. (Prior to Dimaxis 4.0.0, all the images had
to be either in the LTA or in the active database.)
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7.3.6 Query/Retrieve (Pro Version only)

Select the Query/Retrieve command from the DICOM pulldown menu. The Query/
Retrieve function enables you to retrieve images from a DICOM server. Select the Remote
DICOM AE if it is not specified. Click the Query button.

If the Remote DICOM AE has not been specified, use DICOM settings/Applications (see
9.3.1 “Applications” on page 155) to specify the default Q/R application.

Select the Deselect command from the Patient pulldown menu before starting the query
or empty the Patient ID field if you want a list of several patients.
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Choose a patient in the DICOM Query/Retrieve window. Choose next Retrieve or Study,
depending whether you want to retrieve images at a patient level (Retrieve) or images that
belong to a certain study (Study).

If the query fails, the message window shown below appears. The remote DICOM
Application program is either not running or there is a configuration error.
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If you click Study in the DICOM Query/Retrieve window, the Study Selection window
appears. With this selection you can retrieve images belonging to a specific study.

Delete Images Sent to DICOM AE

When an image is sent to a DICOM application, the date when the image was sent will be
recorded in the database. It is possible to delete the sent images from the local Dimaxis
database.

Select the Delete Images Sent to DICOM AE command from the DICOM pulldown menu.
Enter the desired date in the dialog box that appears and click Delete.
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If no images are found, the message window shown below appears. To return to the
Delete Images Successfully Sent to DICOM AE window click OK.

Delete Old Local Worklist

The old entries from the local copy of the Worklist stored in the Dimaxis database are not
automatically deleted. They can be deleted by clicking Yes in the message window shown
below.

7.4 DICOM Pulldown Menu (Image(s) Open) (Pro Version only)

This DICOM pulldown menu is visible when an image is open.

7.4.1 DICOM Storage (Pro Version only)

This function is the same as the DICOM Storage button, refer to section 7.2 “DICOM
Storage (Pro Version only)” on page 72.

7.4.2 DICOM Print (Pro Version only)

This function is the same as the DICOM Print button, refer to section 7 “DICOM” on page
70.

Send images to remote DICOM application
Print images with a DICOM printer

DICOM, see section 7.3 “DICOM Pulldown 
Menu (no Images Open) (Pro Version only)” on 
page 74 for information on these commands.

Create DICOM medias

Print all opened images with a DICOM printer
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7.4.3 DICOM Print All (Pro Version only)

The DICOM Print All command functions in almost exactly the same way as the Print All
command (see section 6.5 “Print All (Pro Version only)” on page 69). The Print All
function has an exact print preview, whereas the DICOM Print All function provides only a
rough approximation.

7.4.4 DICOM Media Storage

Select the DICOM Media Storage command from the DICOM pulldown menu to create
DICOM medias. Fill in the necessary information.
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8 PULLDOWN MENUS
NOTE You can activate all the different functions of the program from the pulldown

menus. The buttons on the toolbars are available only for the central
functions of the program.

NOTE The pulldown menus are different according to whether images are open or
not.

NOTE If there are three dots after a command in the pulldown menu or in the opened
dialog window, it means that by clicking the command there will be more
options to choose from. If the command in the pulldown menu or in the dialog
window is not followed by three dots, there will be no more options.

8.1 Patient Pulldown Menu

The Patient pulldown menu is visible when there are no images open.

Deselect

When you have finished working with the images of one patient, and you do not want to
close Dimaxis, you can deselect the patient by choosing the Deselect command from the
Patient pulldown menu.

 

 

Select a patient, see chapter 4.1 
“Selecting Patient” on page 17.

New patient, see chapter 2.2 
“Selecting Patient” on page 8.

Deselect a patient
Patient statistics
Modify patient information
Change the patient number

Quit Dimaxis 

List of the most recently used 

Delete the patient

Change the printer and printer options
(refer to your Windows manual)

patients
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Statistics

Select the Statistics command from the Patient pulldown menu to see the patient
statistics.
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Modify

Select the Modify command from the Patient pulldown menu to modify the information of
the selected patient.

If you have modified the information of the selected patient in the Modify Patient window
and you click the Modify button, the message window shown below appears. To accept
the modification click Yes, or cancel the action by clicking No.
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If you click Yes, the message window shown below appears.

If you have modified the information of the selected patient in the Modify Patient window
and you click the Cancel button to cancel the modification, the message window shown
below appears. To ignore the changes click Yes, or accept the changes by clicking No.

NOTE If you want to delete an image, but not all the information of the patient, select
the Delete command from the Image pulldown menu, see section 8.8 “Image
Pulldown Menu (Image(s) Open)” on page 97.
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Change the Patient ID

Select the Change the Patient ID from the Patient pulldown menu to change the patient
ID. This function is needed if the patient was originally stored in the database with a wrong
Patient ID.

Delete Patient

When you select the Delete Patient command from the Patient menu, the message
window shown below appears. To accept the removal click Yes, or cancel the action by
clicking No.

If you click Yes, the message window shown below appears.
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NOTE If the patient has any images in the image archive, these images will be
deleted as well. In this case the message window shown below appears. To
accept the action click Yes, or cancel the action by clicking No.

List of the Most Recently Used Patients

Dimaxis remembers each user’s ten most recently selected patients.

Exit

Select the Exit command from the Patient pulldown menu to quit Dimaxis.

8.2 Image Pulldown Menu (no Images Open)

This Image pulldown menu is visible when no images are open.

Select image
Select intraoral images by tooth range
Open the Image Navigator window

Import an image from another system
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Import

You can import TIFF, JPEG and BMP files. To import an image from another system
select the Import command from the Image pulldown menu. The window shown below
appears. Select the image and file type and click Open. See also chapter 9.2.8 “Export” on
page 151.
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The Image Parameters window appears.

If the orientation of the images taken somewhere else is not correct they can be rotated to
the correct orientation already when importing images by using the Rotate function in the
Image Parameters window.

The Magnification field in the image parameters window is used when importing or
scanning images. If the magnification value is given measurements can be performed
without calibrating the image. Add the pixel size, as well. Then add the desired parameter
values and click OK.
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Export All Images

Select the Export all images command from the Image pulldown menu to export all
images of the patient. This command is visible only when no images are open.

If the default export directory has not been specified, the message window shown below
appears. Refer to section 9.2.6 “Directories” on page 148.

The images will be exported to a directory specified by the Patient ID, under the default
export directory.

X-Ray Log Book

The X-Ray Log Book function enables you to take listings of the images taken during a
certain period of time. The default time period is one month but the start date and the end
date can be changed in the X-Ray Log Book window.

The listings of the images can be sorted either by patient or exposure date. The program
remembers the last selection made (user specifically).
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Change the start date or/and the end date if needed by clicking the arrows in the date
boxes. Alternatively you can enter the date on the start date/end date text field.

When you click OK in the X-Ray Log Book window, the XRayLogBook.doc - 

Notepad window with the text file appears. The text file can be printed by selecting the
Print command from the File pulldown menu.

The name of the one who took the X-ray is shown on the list. All the X-rays under the
name have been taken by this person.
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8.3 Capture Pulldown Menu

The Capture pulldown menu is visible all the time.

8.4 Study Pulldown Menu

The Study pulldown menu is visible when no images are open. This menu can also be
opened before selecting a patient.

Working with templates is described in section 11 “STUDY TEMPLATES (Optional only in
US)” on page 165.

8.5 Administration Pulldown Menu

The Administration pulldown menu is visible when no images are open.

Working with settings is described in section 9 “SETTINGS” on page 127.

Expose a cephalometric image

Expose an intraoral image

Capture an Intracam image

Expose a panoramic image

TWAIN interface, see section 5.6 
“Image Plate (CR) Scanner (Pro ver-
sion only)” on page 61 for informa-
tion on these commands.

Create a new template

Edit template

Delete selected template

Copy an existing template

Hide/Unhide template

 

Dimaxis settings, see chapter 9 
“SETTINGS” on page 127.

Log in to the database

In Dimaxis Pro version only

Change the database options

Move image(s) to long term archive, 
see chapter 10 “MOVING IMAGES TO 
LONG TERM ARCHIVE” on page 160.
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Database Login

The Database Login command on the Administration pulldown menu is active when you
are not connected to the Solid database. Use this command to connect to the database.

Database Setup

Select the Database Setup command from the Administration pulldown menu to change
the database startup and shutdown commands.

These fields should be left empty unless Dimaxis is used in a standalone computer and
Solid has not been registered as a service.

When you click User ID, the message window shown below appears.

If you click Yes, the ODBC (Open Database Connectivity) window appears. In that window
you can select the correct data source.
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Database Statistics

Select the Database Statistics command from the Administration pulldown menu to see
the database statistics.

Database Backup Status

The Database Backup Status command works only when using Solid database; other
databases may have more sophisticated tools for this kind of tasks.
The database backup status should be checked regularly.

Database Disk Usage

The Database Disk Usage command works only when using Solid database (Solid 4.1 or
later); other databases may have more sophisticated tools for this kind of tasks. For
example in SQL Server it is possible to configure the DBMS to send an email to the
system administrator if free disk space is lower than a given threshold.
The database disk usage should be checked regularly.
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8.6 View Pulldown Menu

Toolbar

The Toolbar function will show/hide the upper toolbar.

Status bar

The Status bar function will show/hide the status bar located at the bottom of the screen.

“View Box”

The “View Box” function turns the screen white. This option enables you to view film X-
rays.

8.7 Help Pulldown Menu

The Help pulldown menu is visible all the time.

Manual (in PDF format)

The Manual (in PDF format) command on the Help pulldown menu opens the Dimaxis
user’s manual. The manual is in PDF format; Acrobat Reader must be installed to be able
to open the manual.

If Acrobat Reader has not been installed in this computer, the message window shown
below appears.

Show/hide upper toolbar
Show/hide the status bar

Show the “View box”

Select the About Dimaxis command from the Help
pulldown menu to check the Dimaxis version number
if you have to contact the technical support. 
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8.8 Image Pulldown Menu (Image(s) Open)

This Image pulldown menu is visible when an image is open.

Original

If you have opened a modified image or modified the image, the Original command will
revert to the original version of the same image.

Reload

The Reload function is similar to the Original function but Reload will revert to the last
saved version of the image.

Load the original image 
Reload the selected image
Delete the selected image

Select intraoral images by tooth range
Open Image Navigator

Select image

Import an image from another system

Receive diagnostic information of the images
Start another image processing

Move the image to another patient

Subtraction

Export Region of Interest to selected directory
Export the original image to selected directory

Export the image to selected directory

program for Intracam images

Save the modified image
Close the image

Print the image
Show print preview
Print all opened images
Change the printer and printing options
(refer to your Windows manual)
Exit Dimaxis

Send images by email
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Delete

When you select the command Delete from the Image pulldown menu the message
window shown below appears. To remove the selected image from the database click
Yes, or cancel the action by clicking No.

To prevent wrong images from being accidentally deleted, the Delete command is enabled
only if there is only one image open. Before the image is deleted it will be copied to the
Temp folder together with the image and patient information file (image name e.g.
_DEL_00001_50.TIF).

Move to Another Patient

NOTE This command cannot be selected if the image has been manipulated, or if
you have more than one image open.

The Move to Another Patient command enables you to move an image from one patient
to another. If you, for some reason, forgot to change the patient in Dimaxis when you
exposed a new image you can select this command to move the image to the right patient.

The Select Patient window appears. Select or add the patient to whom you want to move
the image and click OK.
98  Dimaxis Pro/Classic User’s Manual



PULLDOWN MENUS
Select the patient from the list that appears and click OK.

You will be asked to confirm the action by clicking Yes. To cancel the action, click No.

Subtract (optional)

The subtraction is a scientifically proven method to assess small differences on serially
taken radiographs (before/later). The digital subtraction (DS) is a widely used method in
the medical field. It requires superimposition of two radiographs to detect the change.
Dimaxis does this based on user defined control points. The control points should be
chosen so that the area of interest is enclosed by the points. The selection of reference
points (or landmarks) is crucial, it has implications for method accuracy.

The subtraction can be used for detecting small lesions, evaluation of periodontal changes
and many other conditions.

There is a user specific setting (see 9.2.10 “Subtract” on page 153) for deciding if the user
wants Dimaxis to optimize the given control points before applying subtraction. The
optimization usually improves the result of subtraction but if the contrast near the control
point is not high enough the algorithm may not be able to do the optimization. And it takes
quite a long time to calculate the optimization.

The Subtraction function usage is controlled with the DLC file.

NOTE To correct differences in projection angles, anatomically identical control
points are necessary for proper geometric alignment.
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How to Use the Dimaxis Subtraction Tool?

1. Open both radiographs to be evaluated in Dimaxis.

2. Click the Control points for subtraction button located on the right toolbar or select the
Control Points for Subtraction command from the Draw pulldown menu and click on the
screen to add four control points to both images. Add the points in a clockwise direction,
first to one image and after that to the other one.

If necessary, you can adjust the location of a control point by left-clicking the mouse on a
point, and while the mouse button is pressed down, dragging the point to the desired
location.

3. Click the Subtract button located on the right toolbar or select the Subtract command
from the Image pulldown menu.

Control points for subtraction button

Subtract button
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4. Dimaxis automatically displays the subtracted image for diagnose.

Import

This command will import an image file or several files from another system.

Export

This command will export an image to the selected directory. Alternatively, you can click
the Export button located on the upper toolbar.

Export Original

This command will export the original image to the selected directory. The Create 8 Bit
Export Files setting in the Local And User Specific Settings/Export window (see 9.2.8
“Export” on page 151) will be ignored. Note that you cannot change the image format.

Export ROI

This command will export the Region of Interest (ROI) to the selected directory.

Decision Support

A separate licence must be purchased to enable decision support. The Decision Support
command activates a separate function which enables you to receive diagnostic
information of the images. Alternatively you can click the Decision support button located
on the upper toolbar. The decision support is meant only for intraoral and panoramic

Export button
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images, and for such panoramic images only where the region of interest has been
chosen.

If the Decision Support has not been installed, the message window below appears.

Edit

This command will start another image processing program (e.g. Adobe Photoshop),
which enables you to manipulate colour images. Alternatively, you can click the Edit button
located on the upper toolbar.

Save

The Save function will save the modifications made to the image. The original image will
also remain in the archive and it can be opened with the Original command.

If you have made modifications to the image and you select the Original command from
the Image pulldown menu, the message window shown below appears. If you want to
open the original version of the same image, click Yes. Cancel the action by clicking No.

NOTE Only one modified version can be saved in the archive. When you save a new
modified version, it will always replace the existing modified version.

Close

The Close function will close the image.

Decision support button

Edit button
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Send by Email

Select the Send by Email command from the Image pulldown menu to send images
directly by email. Dimaxis automatically opens the email dialog of the default email client
application.

Print

Select the Print command from the Image pulldown menu or select Ctrl+P to print
images.

Print Preview

The Print Preview function will show the print preview.

8.9 Edit Pulldown Menu

The Edit pulldown menu is visible when an image is open.

Undo

Select this command or click the Undo button on the right toolbar to undo the image
processing operations you performed, in reverse order, by repeatedly clicking the Undo
button. You can also undo image processing operations made in the previous sessions.

Redo

Select this command or click the Redo button on the right toolbar to redo the operations
you undid, in reverse order, by repeatedly clicking the Redo button. The redo function is
no longer available if you perform any image processing functions, or after saving the
image.

Cut

Select this command or Ctrl+X to cut (= remove) a selected ROI or annotation.

Insert existing images to a study by opening the 
image and selecting Copy, selecting the image 
placeholder and clicking the Paste button.

Undo image processing operations
Redo image processing operations

Cut; remove a selected ROI or annotation

Undo button

Redo button
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Copy

The Copy (Ctrl+C) command can be used to add existing images to the study. In the
Dimaxis version 3.3.0 also the image data will be copied to the clipboard, so the images
can easily be pasted into other software (e.g. Word).

If a region of interest has been selected from the image only the contents of the ROI will be
placed to the clipboard.

8.10 View Pulldown Menu

The View pulldown menu is visible when an image is open.

8.10.1 Upper Toolbar

The Upper Toolbar function will show/hide the upper toolbar.

8.10.2 Right Toolbar

The Right Toolbar function will show/hide the right toolbar.

Show/hide upper toolbar
Show/hide right toolbar

Show/hide the status bar

Viewing tools, see section 8.10.5 
“Viewing Toolbar” on page 113 for
information on these commands.

Show image parameters

Magnification 1:1
Same as - key
Same as Zoom Out
Same as + key
Same as Zoom In

Show the “View Box”
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8.10.3 Measurement Toolbar

Select the Measurement Toolbar command from the View pulldown menu to view the
measurement and the drawing tools. You can alternatively click the Measurement Toolbar
button located on the upper toolbar. The measurement toolbar will appear in the upper
right corner of the display. To move the toolbar click the frame of the toolbar, drag the
toolbar to the desired location and release the mouse button.

NOTE The performed measurement disappears automatically when you select
another function unless “Create Annotation” has been selected in the
Distance Measurement dialog.

 

Measurement

Frame of the toolbar

Calibrate

Measure Length
Measure Angle

Show line profile

Annotation text

Show Histogram

toolbar button

Draw a line

Draw a horizontal line from point

Draw a vertical line from point
Draw an arrow

Draw a rectangle

Draw an ellipse

Show/Hide annotations
Draw a spline
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Calibrate

NOTE If the pixel size and magnification parameters of the image exist, no
calibration is needed!

Before you can measure the distance between selected points, you have to define a
reference distance. Click the CAL button and measure the known length by clicking the
start point, releasing the mouse button and clicking the end point. The Reference
Distance window appears. Enter the distance e.g. in centimeters into the Distance in...
field in the Reference Distance window and click OK. Note that you can use any units you
want. After calibration, all the distances of the current image will be given in the selected
units.

It is possible to make a rough distance measurement before calibrating the image for
distance measurements. In this case there will be a warning before the first measurement
(see below).

Dimaxis remembers the calibration after closing the image, so calibration does not have to
be repeated each time the image is opened.

Measure Length

NOTE You should define the reference distance before using the measure length
function, see section “Calibrate” on page 106.

The horizontal measurements from panoramic images may be inaccurate. Therefore
Dimaxis gives a warning message if the measurement line differs more than 6 degrees
from vertical.

After defining the reference distance click the Measure length button. The Distance
Measurement window appears. A distance path consists of consecutive line segments.
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To draw the line segments click the left mouse button at the start point, release the button
and click the left mouse button at the end point. The length and angle from the horizontal
axis of each segment are shown in the Distance Measurement window.

The distance path and total length are shown on the image after measurement if the
Create Annotation option is selected.

The length and angle of the currently drawn line, as well as the total length of the path, are
shown in the Distance, Angle and Total Length boxes in the Distance Measurement
window.

To end the distance path click the right mouse button, or click the New button in the
Distance Measurement window. To end the distance path and close the window click
OK, and to cancel the meas-urement click Cancel.

Measure Angle

Click the start point, release the mouse button and click the center and the end points to
measure the angle. The angle will be shown in the Angle window.

The measurement line and angle are shown on the image after measurement if the Create
Annotation option is selected. If Create Annotation is not selected the measurement line
disappears when you perform a new measurement.
Dimaxis Pro/Classic 107User’s Manual



PULLDOWN MENUS
Show Line Profile

In the Line Profile window the intensity profile between two selected points on the drawn
line is shown. Click the left mouse button at the start point, release the button and click at
the end point to show the line profile between the selected points. The Line Profile
window will appear and it remains on the screen until you close it or until you close the
image.

Show Histogram

A histogram is a graphic representation of the intensity distribution in the image or in the
Region of Interest (ROI). The Histogram window will remain on the screen until you close
it or until you close the image.

The numerical values at the bottom of the histogram dialog box display statistical
information about the gray level values of the pixels. Total Pixels represents the total
number of pixels used to calculate the histogram. Mean is the average brightness value.
Standard deviation (Std. Deviation) represents how widely the values vary. Median shows
the middle value in the range of gray values.

To view information about a specific point on the histogram, place the point there. To view
information about a range of values, drag in the histogram to highlight the range. 
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The values at the lower right of the dialog box change to display the gray level (Gray
Level) of the point (from 0 to 255), the total number of pixels at that level (Count), and the
percentage of pixels at or below that level (Percentile).

Drawing the Figures

Click the button of the desired tool and then click the left mouse button at the start point of
the object, release the mouse button and click the left mouse button at the end point. The
tool is automatically deselected when it has been used, if another tool or command is
selected or if you press the ESC key.

Annotation Text

Click the annotation text button and the desired text position in the image. The Annotation
Text dialog box appears. Enter the annotation text and click OK. You can change the text
later by double- clicking the text in the image.

Show/Hide Annotations

Click the Show/Hide Annotations button to show or hide the annotations made on the
image.

Annotation Text
button

Show/Hide Annotations
button
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8.10.4 Image Processing Toolbar

Select the Image Processing Toolbar command from the View pulldown menu to view
the filter tools. You can alternatively click the Image Processing Toolbar button located on
the right toolbar. The image processing toolbar will appear in the upper right corner of the
display. To move the toolbar click the frame of the toolbar, drag the toolbar to the desired
location and release the mouse button.

Filters can be used to improve the image quality and to emphasize the desired properties.
However, using the filters may cause some image information to be lost and thus affect
the diagnostic value of the image. The original image can be reloaded from the database.

If the image processing toolbar was open when you closed the last image, the image
processing toolbar is automatically opened when you open the next image.

Sharpening Filter (Pro Version only)

With the sharpening filter it is possible to sharpen the image by emphasizing high
frequencies. However, the image noise increases at the same time.

Adjustable Sharpening Filter (Pro Version only)

It is possible to select a default sharpening filter or an adjustable sharpening filter. Click
the Adjustable Sharpening Filter button to open the Sharpening Filter window where
you can define the filter radius and scale factor of the image. The filter radius can vary
between 1-9, the scale factor amount can be 115-300. Dragging the scale factor control to
the right causes stronger filtering.

By clicking the Defaults button the Dimaxis default values for the filter will be restored.

Frame of the toolbar

Image Processing

Soften the image to remove noise

Sharpen the image (Sharpening

Remove noise (Median Filter)

Adjustable Sharpening Filter (Pro version only)

Flashlight Setup (Pro version only)

Flashlight (Pro version only)

Enable/Disable Soft Tissue Filter (cephalometric images only)

Optimize for Diagnose

Optimize Contrast

Gradient Image (edge operator)

Emboss (3D effect)

(Softening Filter)

Manual Adjustment of Soft Tissue Filter Edges (cephalometric images only)

Filter) (Pro version only)

toolbar button
110  Dimaxis Pro/Classic User’s Manual



PULLDOWN MENUS
In the Sharpening Filter window you can also define if you want to save the adjusted
values as user specific default values.

Equalize

The Equalize function redistributes the brightness values of the image pixels in an image
so that they more evenly represent the entire range of brightness levels.

Soft Tissue Filter Enabled (Cephalometric Images Only)

Click the Soft Tissue Filter Enabled button or select the Soft Tissue Filter Enabled
command from the Process pulldown menu (see section 8.13 “Process Pulldown Menu”
on page 120) to enable/disable the automatic soft tissue filter function for cephalometric
images. A tick in the menu indicates that the function is in use.

Adjust Soft Tissue Filter (Cephalometric Images Only)

If the automatic soft tissue filter operation produces unsatisfactory results, click the Adjust
Soft Tissue Filter button or select the Adjust Soft Tissue Filter command from the
Process pulldown menu (see section 8.13 “Process Pulldown Menu” on page 120) to
manually adjust the position of the soft tissue filter edges. The cursor will change to a soft
tissue filter symbol and two green lines (indicating the edge positions) will appear on the
image. Position the soft tissue filter symbol on the edge you wish to move and drag it with
your mouse to a new position. The image will automatically be refiltered.

The intensity of the soft tissue filter for the cephalometric images can be adjusted. The
default value can be configured according to the instructions in section 9.1.5
“Cephalostatic” on page 134, and the filtering can also be adjusted for each image with the
Adjust Soft Tissue Filter command. Dragging the cursor up makes the filtered area
lighter and dragging it down makes the image darker.

NOTE Soft tissue assessment was previously a mechanically integrated function in
the cephalostat. In the Dimax3 digital Ceph system it is a software feature.

Adjustable
Sharpening
Filter button
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Flashlight (Pro Version only)

The flashlight function enables the user to perform temporary image emphasizing/
processing operations. The different operations can be seen in the Flashlight Setup
window (see next page).
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Flashlight Setup (Pro Version only)

In this window you can choose the command for the flashlight. Here you can also define
the form of the window (circular or rectangular).

If you select Sharpen, the message window shown below appears.

8.10.5 Viewing Toolbar

Select the Viewing Toolbar command from the View pulldown menu to view the viewing
tools. You can alternatively click the Viewing Toolbar button located on the upper toolbar.

Full Screen Mode

Viewing Toolbar
button

Show the Overview Image
Magnify 2x
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Full Screen Mode

Click the Full Screen Mode button to enter the full screen mode.

Zoom the image in/out with the keyboard plus (+) and minus (-) keys, and move up and
down with the arrow keys and the page up/down keys. Return to the normal mode by
pressing the ESC key or clicking the Normal View button on the lower edge of the screen.

Overview Window

In the Overview window the entire image is shown and the enlarged part is marked with a
green rectangle. The enlarged part can be moved by dragging the green box.

The Overview window is not shown on the display if the whole image fits on the screen.

Close the Overview dialog either by clicking again the Overview button on the upper
toolbar or selecting again the Overview command from the View pulldown menu.

In section 9.1.4 “Panoramic” on page 133 you can determine if you want to open the
Overview window when opening a panoramic/cephalometric image.
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Magnify 2x

The Magnify 2x tool will open a separate magnifier (see below). The part of the image that
is under the cursor is shown enlarged. To move the magnifier simply drag the mouse in
any direction.

Close the Magnify 2x tool either by clicking again the Magnify 2x button on the upper
toolbar or selecting again the Magnify 2x command from the View pulldown menu.

8.10.6 Rotating Toolbar

Select the Rotating Toolbar command from the View pulldown menu to view the rotating
tools. You can alternatively click the Rotating Toolbar button located on the upper toolbar.
The mirror vertical tool turns the image 180° round the vertical axis, and the mirror
horizontal turns it 180° round the horizontal axis. The rotating tools rotate the image 90°
round its centre either clockwise or counterclockwise.

Viewing toolbar

Magnify 2x tool

Magnify
2x

Horizontal Mirror
Rotate Clockwise

Rotating Toolbar
button

Vertical Mirror

Rotate Counterclockwise
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NOTE Rotation functions are relevant only for imported or scanned images.

NOTE Orientation for exposed intraoral images should be defined in the Intraoral
Exposure or Intraoral Image Parameters window. Rotation functions are
disabled if the orientation of the image has already been defined.

NOTE Rotation (or orientation) can be defined for unmodified images only.

8.10.7 Zoom In Mode

This function is the same as the Zoom In button. The Zoom In button is located on the
upper toolbar. Select this command and then click the area of the image you want to zoom
in. You can repeat the zooming by clicking the image again. Hold down the ALT key and
then click the image to reduce it. You can also zoom out by clicking the right mouse
button.

8.10.8 Zooming In

The Zoom In function magnifies the image in the same way as the + key of the keyboard.

8.10.9 Zoom Out Mode

This function is the same as the Zoom Out button. The Zoom Out button is located on the
upper toolbar. Select this command and then click the area of the image you want to zoom
out. You can repeat the zooming by clicking the image again. Hold down the ALT key and
then click the image to enlarge it. You can also zoom in by clicking the right mouse button.

8.10.10 Zooming Out

The Zoom Out function reduces the image in the same way as the - key on the keyboard.

8.10.11 Zoom 100%

The Zoom 100% function will show the image in a size where one pixel in the image
corresponds to one pixel on the screen, i.e. the magnification is 1:1. Note that the 1:1
(100%) view is based on the screen and image resolutions, and not on the actual image
dimension.

8.10.12 Image Parameters

The Image Parameters function will show the parameters of the open image. The same
Image Parameters window can also be opened from the Select Image window by clicking
the Parameters button.

Zoom In
button

Zoom Out
button
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8.11 Draw Pulldown Menu

The Draw pulldown menu is visible when an image is
open.

Drawing Toolbar, see section 
8.10.3 “Measurement Toolbar” 
on page 105 for information on 
these commands.

Show Annotations, see section 
“Show/Hide Annotations” on 
page 109 for information on this
command.

Region of Interest
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Region of Interest (ROI)

Select the Region Of Interest (ROI) command from the Draw pulldown menu to modify a
part of an image. Alternatively you can click the Region of Interest button located on the
right toolbar and then click the left mouse button at the start point of the region, release the
mouse button and click the left mouse button in the end point. The region of interest is
shown with blue/white borders when the region is selected. Then the actions performed
will be effective only in this region.

You can draw several regions of interest to the image, and they can be moved on the
image.

To delete the region of interest select it by clicking inside its borders and then press the
DELETE key (or Ctrl+X). The message window shown below appears. Click Yes to delete
the region of interest, or cancel the action by clicking the No button.

Region of Interest button

Region of InterestBorders
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8.12 Measure Pulldown Menu

The Measure pulldown menu is visible when an image is
open.

Diagnose Window

Select the Diagnose command from the Measure pulldown menu to type the diagnose
text in the text box that appears. You can alternatively click the Diagnose button located
on the upper toolbar. Click OK to save the text.

The Diagnose button remains selected on the upper toolbar if an image has been saved
with a dia-gnose.

The diagnose will be printed with the image when printing single images if you have
selected “Detailed” option in the Local And User Specific Settings/Printer window (see
section 9.2.1 “Printer” on page 140).

Measurement Toolbar, see 
section 8.10.3 “Measurement 
Toolbar” on page 105 for infor-
mation on these commands.

Open the diagnose window

Diagnose
button
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8.13 Process Pulldown Menu

The Process pulldown menu is visible when an image is open.

Adjust Levels

When a new image is taken the Adjust Levels function is automatically performed on the
image, unless otherwise specified (see chapter 9 “SETTINGS” on page 127). If this
adjustment is not satisfactory, you can do the adjustment manually by selecting the
Adjust Levels command from the Process pulldown menu or alternatively by clicking the
Adjust Levels button located on the right toolbar.

Low (black)/high (white): image tones to be cut in the ends of the histogram in order to
gain reasonable contrast. The Midtones value affects the gamma curve of the image. By

Rotating Toolbar, see section 
8.10.6 “Rotating Toolbar” on 
page 115 for information on 
these commands.

Image Processing Toolbar, see 
section 8.10.4 “Image Process-
ing Toolbar” on page 110 for 
information on these com-
mands.

Show Adjust Levels window

Flashlight, see section 8.10.4 
“Image Processing Toolbar” on 
page 110 for information on 
these commands.

Invert the image
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adjusting the gamma value, you get an image that looks more like a conventional X-ray
image.

If the Adjust Levels function has already been applied to the image, the message window
shown below appears. To undo the previous level adjustment(s) click Yes, or click No to
keep them.

Adjust Contrast/Brightness

Select the Adjust Contrast/Brightness command from the Process pulldown menu. By
doing this you can adjust the contrast and brightness of the image with the mouse. Click
the left mouse button and do not release it. When you drag the mouse vertically, you can
adjust the contrast of the image. When you drag the mouse horizontally, you can adjust
the brightness of the image.

The Contrast/Brightness button on the right toolbar functions similarily to the pulldown
command Adjust Contrast/Brightness.

Adjust Levels button

Contrast/brightness button
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You can alternatively click the Brightness button located on the right toolbar to make
simple adjustments to the tonal range of the image (see next page). Drag the slider to
adjust the brightness of the image. Dragging upwards decreases the level and dragging
downwards increases it. The number below the slider displays the brightness value.
Values can range from -50 to +50.

Click the Contrast button located on the right toolbar to make simple adjustments to the
tonal range of the image. Drag the slider to adjust the contrast of the image. Dragging
upwards decreases the level and dragging downwards increases it. The number below the
slider displays the contrast value. Values can range from -50 to +50.

Reset Contrast/Brightness

Select the Reset Contrast/Brightness command from the Process pulldown menu to set
the contrast and brightness back to zero.

Optimize Contrast

The Optimize Contrast command can be used only with an unmodified image (use the
Undo command if necessary).

After selecting the Optimize Contrast command from the Process pulldown menu click
the area to be optimized. This option optimizes the image for the diagnose needed (e.g.
for the root canal).

Description
The purpose of this function is to optimize the contrast of a complete image. The function
makes the Dixi digital radiographs filmlike. When a conventional dental film is viewed on a
light box, the human visual system perceives equal steps in object thickness as
approximately equal steps in light intensity.

The Optimize Contrast function uses two algorithms to recalculate the image data. The
first algorithm is a so-called gamma correction giving the result that equal steps in object
thickness will be displayed on the computer monitor as equal steps in brightness. Since
the response of the human visual system to the light intensities is non-linear, the second
algorithm takes this response into account. The final result is that equal steps in object
thickness will be perceived as equal steps in brightness.

The last statement is fully true only for a homogeneous object. Regarding a true object
with different tissues having a different attenuation of X-rays, the result will be a kind of
weighted averaging. Thus, the real result is that equal steps in object thickness will be
perceived as approximately equal steps in brightness.

NOTE The Optimize Contrast function works only with 16 bit images.

Application
Select the Optimize Contrast command from the Process pulldown menu. Then move
the cursor to a reference point on the image and click the left mouse key. The image will
be instantly recalculated.

Brightness button Contrast button
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NOTE The selection of the reference point is important for optimal result.

The reference point should be selected within the brightest area of a radiograph but NOT
in a filling.

Normally the ideal reference point should be taken in the sound enamel of the brightest
tooth. In certain instances some other area of a radiograph may, however, be brighter than
the enamel, e.g. the compact bone. In that case the reference point should be taken in that
area.

Optimize for Diagnose

Description
This function uses the same algorithms as the Optimize Contrast function with one
additional recalculation of the image data that shifts the average brightness in a region of
interest to the mean of the brightness range of the computer monitor. This is performed
because the perception is optimum in the middle of the brightness range.

When this function is used a selected region of interest will be optimized for diagnostic
tasks.

NOTE It is important to know that other areas than the region of interest may be
destroyed with respect to the diagnostic image quality. This is so because no
radiograph can be optimized simultaneously in all regions and over all
brightnesses. For multiple diagnostic tasks, recalculate the radiograph with
respect to the different regions of interest.

NOTE The Optimize for Diagnose function works only with 16 bit images.

Application
Select the Optimize for Diagnose command from the Process pulldown menu. Then
move the cursor to a reference point on the image and click the left mouse key. The image
will be instantly recalculated.

The reference point should be selected in a region of interest.

For a caries diagnosis, select the reference point in the sound enamel outside any
suspected lesion.

For any type of diagnosis of bone structures, periapical or periodontal, select the
reference point in the sound bone in a region of interest but outside any suspected lesion.

To evaluate root fillings or identify root canal files, select the reference point in the
filling or file close to the apex.

For other diagnostic tasks, employ the above principle when selecting the reference
point.
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Pseudocolors

Select the Pseudo Colors command from the Process pulldown menu to change the
colour palette from gray scale to coloured and to open the Pseudocolors window. You
can alternatively click the Pseudocolors button located on the right toolbar. In this window
you can select the colour type. The option Black Object will display a colour palette based
on the different colours a blackbody radiator emits as it is heated (from black to red,
orange, yellow and white). The option Spectrum will display a colour palette based on the
colours produced as white light passes through a prism (from violet, blue and green to
yellow, orange and red). You can adjust the pseudocolors by dragging the sliders next to
the windows.

Invert the Image (Negative Image)

Select the Invert command from the Process pulldown menu to turn the dark parts of the
image light, and vice versa. You can alternatively click the Invert button located on the
right toolbar.

Pseudocolors
button

Invert
button
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8.14 Window Pulldown Menu

The Window pulldown menu is visible when an image is open. The Tile commands are
used to position the current set of open windows in the selected format on the screen.

New Window

The New Window function opens a new window with the selected image.

Cascade

The Cascade function arranges two or more image windows in a form of a cascade.

Tile Horizontally

The Tile Horizontally function places image windows one above the other.

Tile Vertically

The Tile Vertically function places image windows side by side.

Tile 2A (Vertical)

The Tile 2A (Vertical) function places two image windows side by side.

Tile 2B (Horizontal)

The Tile 2B (Horizontal) function arranges two image windows one above the other.

Tile 3A (Vertical)

The Tile 3A (Vertical) function places three image windows side by side.

Tile 3B (Horizontal)

The Tile 3B (Horizontal) function arranges three image windows one above the other.

Open a new window with the

Arrange image windows as cascade
Tile image windows horizontally
Tile image windows vertically

Tile two image windows vertically
Tile two image windows horizontally
Tile three image windows vertically
Tile three image windows horizontally
Screen divided into three parts
Tile six image windows vertically
Tile six image windows horizontally

The active

selected image

image
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Tile 3C (Divided)

The Tile 3C (Divided) function divides the screen into three parts (two same-size windows
side by side and one bigger window below them).

Tile 6A (Vertical)

The Tile 6A (Vertical) function displays six image windows in format 3x2 (three windows
side by side in two rows).

Tile 6B (Horizontal)

The Tile 6B (Horizontal) function displays six image windows in format 2x3 (two windows
side by side in three rows).

NOTE The options which are ticked in the menu are remembered and used
automatically. For example, if you have three images open and close one
window, the two remaining images will be displayed according to the option
ticked for two open images.
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9 SETTINGS
Choose the Global Settings, Local Settings or DICOM Settings command from the
Administration pulldown menu to check or change the Dimaxis settings. The
Administration pulldown menu is shown when there are no images open.

Select the settings to be checked/changed from the tabbed panes at the top of the Global
Settings, Local And User Specific Settings and DICOM Settings window.

NOTE It is possible to prevent users from changing Dimaxis settings, doing long
term archiving and editing study templates. This can be achieved by adding
the following lines to the file Dimaxis.ini (1=enabled, 0=disabled):
[PERMISSIONS] Admin=1 DeleteImage=1

 

Tabbed

panes 
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9.1 Global Settings

9.1.1 Patient

In the Patient window you can change the name formatting, sort order, name display
order, minimum patient ID length and patient numbering properties (see next page).

The Minimum Patient ID length can be changed by clicking the arrow buttons. If the user
enters a number shorter than the minimum length, zeroes will be added to the left of the
number.

If you have selected the option Automatic numbering for new patients and you leave the
Patient ID box empty, Dimaxis will automatically give the next free patient ID to the new
patient.

When choosing Patient ID = Social Security Number. Check format. the country must be
selected to enable social security number checking. The options are Finland and Sweden.
If this option is selected, Dimaxis checks the correctness of the social security number
when creating a new patient.

If the Show Patient ID in the title bar option is selected, the patient ID is shown in the title
bar of the main window.

If you have chosen the option Automatic wild card usage in selection you only need to
enter the beginning of the patient name when selecting a patient.

It is possible to search patients by using a “quick-pid” patient identifier shortcut (the option
Search using Quick PID) which consists of the initial of the patient’s last name followed by
the last four digits of the patient ID/social security number (e.g. “R1234”).

If the Birth date is mandatory option is selected, giving the birth date when creating a new
patient is obligatory.

If the Birth date in YYYYMMDD format option is selected, the patient’s date of birth is
stored in YYYYMMDD format. By selecting the option Birth date in YYYYMMDD format
you will be able to select/unselect the option Birth date formatting based on regional
settings.
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9.1.2 Image

In the Image window you can select different image formats for panoramic, cephalometric,
intraoral and Intracam images. The Tagged Image File Format (TIFF) is a bitmap image
format. The Joint Photographic Experts Group (JPEG) format uses a compression
scheme that effectively reduces the file size by identifying and discarding extra data not
essential to the display of the image. BMP is the standard Windows bitmap image format.
See also IMPORTANT NOTE in section 1.5 “Archiving” on page 3.

You can also choose the Default Image Selection Method. This selection determines
which window will be opened after you have selected the patient.

The options are:

•None: No image selection window opens.

•Standard: The Select Image window opens.

•Tooth Range: The Tooth Range window opens.

•Image Navigator: The Image Navigator window opens.
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If you choose the option Image Navigator you have to give the tooth numbers and define
the alignment.

If you select the option Images can only be deleted for specified time (hours) after
exposure you have the possibility to define the length of the time period (in hours) during
which the images can be deleted (e.g. 24 or 48 hours).

If you choose the option Open images in Zoom mode the images are in the zoom mode
when they are opened.

The setting Give warning after the number of images in the database exceeds enables you
to specify a threshold value for the number of images in the database. Dimaxis will give a
warning when the number of images in the database gets near the specified value. The
default limit is 20000. If the value 0 is given in the field Dimaxis does not give a warning
about the number of images.

With the last setting Interval (days) between showing Monitor Test Image Dimaxis can be
configured to show a Monitor Test Image at the startup after every given number of days
have passed (see next page). The value 0 means that the test image is never shown
automatically.
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The test image is specified by the Society of Motion Picture and Television Engineers
(www.smpte.org), and follows the SMPTE Recommended Practise RP 133-1991 -
Specifications for Medical Diagnostic Imaging Test Pattern for Television Monitors and
Hard-Copy Recording Cameras. This image should be used for monitor setting and quality
checks:

- Before every working day: The 5% gray field inside the 0% field and the 95% gray field
inside the 100% field should be visible. If not, adjust the brightness and contrast of the
monitor.

- Every month: The line raster in the corners and in the center must be visible, the vertical
and horizontal lines must form undistorted squares and the homogenous gray background
must not be coloured.
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9.1.3 Window

If the Dimaxis Always On Top option is selected in the window, Dimaxis will always be the
topmost window. If the Remember window position after exit option is selected, the
Dimaxis window position and size are retained when you reopen the program.

If you select the automatic tiling of the image windows the program will divide the screen
into equal sections when more than one image is open.

With the Place latest image to left on the screen option it can be controlled in which order
the images are displayed on the screen. This is particularly important for the bitewing
images.

In the window you can change the background colour of the X-rays and the Intracam
images. To specify a custom colour choose Custom. Click Define Custom Colors from the
Color window to define a custom colour.

It is recommended to use the default background colour violet in the Image Navigator
window. Refer to section 4.4 “Image Navigator” on page 38.
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9.1.4 Panoramic

In the Panoramic window you can select the resolution mode for panoramic images.
Select the option Enhanced (pixel size 0.099 mm) or High (pixel size 0.066 mm) to
increase the resolution of the images to be exposed. Note that the size of the image is
much larger and the handling of the image is slower than in the normal mode (pixel size
0.132 mm).

The Bits Per Pixel selection enables you to determine if you want to take 8 bit images.
Note that the best possible dynamic contrast range is reached by using 12 bits per pixel,
but the images will be twice the size of 8 bit images.

The Auto Level Parameters for panoramic images are adjusted in this window. There are
two different types of parameters: first for non-logarithmic mapping of the images and
second for logarithmic mapping. To choose between the logarithmic or non-logarithmic
processing of the images, open the DidapiConfig in the Dimaxis folder. In the Image
Preprocessing tab you can find the appropriate Logarithmic Mapping that you can tick or
un-tick in the panoramic settings (refer to the Dimaxis Installation Manual, APPENDIX F:
DIDAPI CONFIGURATION). When a new image is taken the Adjust Levels operation is
automatically performed on the image. If this adjustment is not satisfactory, you can undo
it by clicking the Undo button and do the adjustment manually, see section “Adjust Levels”
on page 115. If, for some reason, the automatic adjust levels operation repeatedly
produces nonsatisfactory results, these parameters can be adjusted. Black (low)/white
(high): percentage of the image tones to be cut in the ends of the histogram in order to
gain reasonable contrast. The Midtones value affects the gamma curve of the image. By
adjusting the gamma value, you get an image that looks more like a conventional X-ray
image.

Acceptable Limits for Quality Indicator (EQN-Exposure Quality Normalized) can be
set with the range between Low and High (see 5 “IMAGE ACQUISITION” on page 40).

If you want to use the Auto Filter you can select it in this window. If either of the options
(Sharpen/Median) is selected the specific filter will be used automatically on the opened
images (only on the images that have not been saved with the Image->Save function).

The Exposure selection enables you to determine if you want to allow rejecting the images
during the exposure.

The Overview selection enables you to determine if you want to open the Overview
window when opening the image.
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Select the option Zoom To Fit, 100% or 50% to determine the initial magnification.

9.1.5 Cephalostatic

In the Cephalostatic window you can select the resolution mode for cephalometric
images. Select Enhanced (pixel size 0.099 mm) to increase the resolution of the images to
be exposed. Note that the size of the image is much larger and the handling of the image
is slower than in the normal mode (pixel size 0.132 mm).

The Auto Level Parameters for cephalometric images are adjusted in this window. There
are two different types of parameters: first for a non-logarithmic mapping of the images
and second for a logarithmic mapping. To choose between the logarithmic or non-
logarithmic processing of the images, open the DidapiConfig in the Dimaxis folder. In the
Image Preprocessing tab you can find the appropriate Logarithmic Mapping that you
can tick or un-tick in the cephalostatic settings (refer to the Dimaxis Installation Manual,
APPENDIX F: DIDAPI CONFIGURATION). When a new image is taken, the Adjust Levels
operation is automatically performed on the image. If this adjustment is not satisfactory,
you can undo it by clicking the Undo button and do the adjustment manually, see section
“Adjust Levels” on page 120. If, for some reason, the automatic adjust levels operation
repeatedly produces nonsatisfactory results these parameters can be adjusted. Black
(low)/White (high): percentage of the image tones to be cut in the ends of the histogram in
order to gain reasonable contrast. The Midtones value affects the gamma curve of the
image. By adjusting the gamma value, you get an image that looks more like a
conventional X-ray image.

Acceptable Limits for Quality Indicator (EQN-Exposure Quality Normalized) can be
set with the range between Low and High (see 5 “IMAGE ACQUISITION” on page 40).
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If you want to use the Auto Filter you can select it in this window. If either of the options
(Sharpen/Median) is selected the specific filter will be used automatically on the opened
images (only on the images that have not been saved with the Image->Save function).

The default intensity of the soft tissue filter for the cephalometric images can be adjusted
in this window.

9.1.6 Intraoral

In the Intraoral window you can select the resolution mode for intraoral images. Select
High (pixel size 0.019 mm) to increase the resolution of the images to be exposed. Note
that the size of the image will be four times larger and the handling of the image is slower
than in the normal mode (pixel size 0.038 mm).

The Bits Per Pixel selection enables you to determine if you want to take 8 bit images.
Note that the best possible dynamic contrast range is reached by using 12 bits per pixel,
but the images will be twice the size of 8 bit images.

When a new intraoral image is taken the Adjust Levels (Auto Levels) operation can be
automatically performed on the image. See section  “Adjust Levels” on page 120. The
adjustment can be undone after the image has been opened by clicking the Undo button
or selecting the Undo Levels command from the Edit pulldown menu.

The Tooth Identification System (FDI/ISO or ADA) used in the Tooth Range and Image
Navigator windows is selected in this window.
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The Auto Level Parameters which are used in the adjust level operation on intraoral
images, are adjusted in this window. Refer to previous page for more information on these
settings.

Acceptable Limits for Quality Indicator (EQN-Exposure Quality Normalized) can be
set with the range between Low and High (see 5 “IMAGE ACQUISITION” on page 40).

If you want to use the Auto Filter you can select it in this window. If either of the options
(Sharpen/Median) is selected the specific filter will be used automatically on the opened
images (only on the images that have not been saved with the Image->Save function).

Select the option Zoom To Fit, 100% or 50% to determine the initial magnification.

If the option Tooth Number required for new images is selected, you can not exit the
Intraoral Exposure window without giving the tooth numbers and the message window
shown below appears.
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9.1.7 Study (Optional only in the US)

In the Study window you can determine if you want to use studies in intraoral exposures.
If this option is disabled, clicking the Intraoral Exposure button on the upper toolbar or
choosing Intraoral Exposure command from the Capture pulldown menu does not open
the Select a Study window. See section 5.3 “Taking an Intraoral Exposure” on page 52.

If the option Show Study Comment window when creating new studies is not selected, no
note for the study will be prompted when creating a new study.

In this window you can also define if you want to show the images of a study with a higher
resolution.

Optimize horizontal layout of images will adjust the images of a study to use the space
of the paper at the best to print. Also an adjustment for studies exported as an image view
will be done.
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The Show Study Comment dialog before every exposure activates a dialog box to
enter a comment line and DICOM specific information before every exposure of an image.
This information will be saved with the image.

9.1.8 System 

In the System window you can predefine a timeout, when Dimaxis is used by another
software via PmBridge (see further information on PmBridge in APPENDIX A:
PMBRIDGE). If Allow timeout for PmBridge session is ticked, Dimaxis will shut down
after a certain time period, which can be modified in the right side of the System window.
This means that Dimaxis, which is activated via PmBridge for example by practice
management software, shuts down after the adjusted time period and prevents redundant
activity of Dimaxis on the computer. The countdown of the timeout begins with the start up
via PmBridge, but resets for the activation of the following processes in Dimaxis:

•Image selection

•Every kind of exposure

•Patient selection

•TWAIN-scanning

•Direct-scanning

•DICOM storage

•DICOM printing
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This means that for example the selection of a new patient resets the time and the
countdown of the timeout restarts again. 

NOTE The adjustable Time-out value is only approximate and not an exact value.
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9.2 Local And User Specific Settings

9.2.1 Printer

In the Printer window you can select the default printer for Dimaxis. Note that the Dimaxis
default printer can be other than the Windows default printer. 

NOTE In the Microsoft Windows ME operating system the printer has to be defined
explicitly to enable printing.

The print size of the images can be adjusted with the Scale Factors. Enter a new scale
factor or adjust the value by clicking the arrow buttons. To return to the default scale
factors, click the Defaults button.

Note that the size of the panoramic and cephalometric images is adjusted only when they
are printed as part of a study.

In this window you can also set the margins (in centimeters) for the images. This setting
affects the printing of the single image, the study and the Print All function.

To see the size of the image to be printed, open the image and select the Print Preview
command from the Image pulldown menu. Note that if you print several images from a
study at the same time, they will be fitted to one page, regardless of the scale factors you
have selected here.

In the Printer window you can also configure the background colour (White/Black) for the
printed images. (The black background can only be recommended when using a film
printer.)

If the image is larger than the print area you can either select the Crop to fit option or the
Shrink to fit option in this window to reduce the image size. This setting affects the printing
of the single image, the study and the Print All function (not the DICOM printing).
140  Dimaxis Pro/Classic User’s Manual



SETTINGS
Additionally, you can define the format of the patient information here (see below and next
page).

NOTE Settings for printer apply to the local workstation only.

If the Compact option is selected, the patient information is in short format when printing
the image (see below).

If the Detailed option is selected, you can write the Footer Text. The footer text can for
example include the name of the clinic. The Detailed option displays the information with
headings (“Patient’s name”, “Patient ID” etc.).
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Additionally, it is possible to print the image with a diagnose when the option Detailed is
selected (see section  “Diagnose Window” on page 119 for more information).

9.2.2 User

In the User window you are able to determine the default panoramic and intraoral user
and the default doctor.
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9.2.3 Intraoral

If the Always Ready for Exposure feature is enabled in the Intraoral window, the Dixi
images can be taken without clicking the exposure icon in Dimaxis. In this case, as
always, the images can only be taken if the “Ready” LED is on in the Dixi control box. The
images will not automatically be part of the studies if Always Ready for Exposure is used.

If the Use Intra Control Panel feature is enabled, the Intra control panel will appear in the
Intraoral Exposure window.

In the Cone Type field you can select the appropriate cone for the Intra.
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9.2.4 Intracam Setup

In the Intracam Setup window you can select the communication port (1 or 2) into which
the foot control for freezing and saving Intracam images is connected. Select 9 if no foot
control is available.

You can also select the external editing program (Photoshop or other image processing
program). 

Enable Undistortion to level distortions of Intracam images automatically.

NOTE Settings for Intracam apply to the local workstation only.
144  Dimaxis Pro/Classic User’s Manual



SETTINGS
Click the Video button to adjust the Intracam image. The Video Setup window appears.

If the video card or driver has not been installed, or the driver is incorrectly configured, the
Video Setup window does not appear. Instead the message window below is shown.

NOTE The Video Setup windows depend on the video card. The following Video
Format, Video Source and Video Display windows are only examples.
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Click the Format button and the Video Format window appears. In this window you can
adjust the Intracam image dimensions and image format.

Click the Source button and the Video Source window appears. In this window you can
select the video signal type and colour television broadcasting standard.

Click the Display button and the Video Display window appears. In this window you can
adjust the colour settings etc. of the image. Note that all video cards do not have this
dialog box.
146  Dimaxis Pro/Classic User’s Manual



SETTINGS
Normally there is only one video capturing device available. If there is more than one
device, the desired one can be selected from the Device selection.

9.2.5 CR Scanner (Pro version only)

In the CR Scanner window you can select the scanner type.

NOTE Settings for Scanner apply to the local workstation only.
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9.2.6 Directories

The export, import and long term archive root directories are defined in the Directories
window. Note that the long term archive root directory must be specified before you can
move images to the long term archive. Refer to section 10 “MOVING IMAGES TO LONG
TERM ARCHIVE” on page 160 for further information.

New images will be saved to the temporary directory before they are stored into the
database.

NOTE Settings for Directories apply to the local workstation only.
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Use the Browse button in the Directories window to locate the directory.

An error message is given if it is not possible to write to the temporary directory. Dimaxis
checks this during the startup. This problem can occur for example if the temporary
directory has been specified to a network drive which no longer exists.
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9.2.7 Icons (Pro Version only)

In the Icons window you can select the buttons which you do not wish to have in the
toolbar by unchecking them.
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9.2.8 Export

In the Export window you can define if you want to make 8 bit export files. Internally,
Dimaxis uses 16 bit images, unless the Bits Per Pixel setting for panoramic or intraoral
images has been changed to 8 bits. Many other systems can only read 8 bit images.

In this window you can also define if you want to create a patient and image information
file (image parameters etc.). See also chapter  “Import” on page 89.

“Burn” patient info and annotations into the export file enables you to get the patient
information and annotations under the exported image the same way when printing an
image.

“Text Encoding” enables you to choose the text standard used for your exported data. 
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9.2.9 TWAIN

In the TWAIN window it is possible to specify whether the file transfer mechanism is used
when acquiring images from a TWAIN source. In Dimaxis versions 3.2.4 to 3.3.2 the file
transfer mechanism is used (if it is available) to be able to capture images with 16 bit. The
problem with that is that even if some TWAIN data sources claim that they support the file
transfer they do not necessarily support it.
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9.2.10 Subtract

In the Subtract window there is a user specific setting for deciding if the user wants
Dimaxis to optimize the given control points before applying subtraction. The optimization
usually improves the result of subtraction but if the contrast near the control point is not
high enough the algorithm may not be able to do the optimization. It takes quite a long time
to calculate the optimization.
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9.2.11 System

To avoid running multiple Dimaxis sessions on one computer tick the Allow only one
session option to run in the System window. This option prevents the accidental opening
of two sessions (more than one license assumed).

If another Dimaxis session is opened simultaneously, a Splash Message appears to
remind you about the session already running.
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9.3 DICOM Settings (Pro Version only)

9.3.1 Applications

DICOM (Digital Imaging and Communications in Medicine) is a standard for the
communication of medical images and associated information.

In the Applications window you can select the default destination (storage application) for
images to be sent by clicking the upper Select button.

You can select the default DICOM printer by clicking the corresponding Select button. You
can select the default worklist by clicking the respective Select button. You can select the
default Q/R by clicking the lowest Select button. In all cases the Select Remote DICOM
AE window appears.

From the Dimaxis version 4.0.0 on the DICOM applications can be configured directly from
Dimaxis. The information is saved into the Dimaxis database. Earlier this had to be done
by editing a separate configuration file.
For more information refer to the Dimaxis Pro/Classic’s Installation manual.

If there are several Dimaxis workstations in the network, the workstations should have
different AE Titles, for example DIMAXIS_1, DIMAXIS_2 etc.

By selecting the Default Worklist AE you will be able to select/unselect the option Use
Worklist for patient selection. If the Worklist has been selected the Worklist window
(instead of the Select Patient window) will be opened when starting up the program.

NOTE Settings for Applications apply to the local workstation only.

 

workstation
this Dimaxis
entity title of
application
DICOM
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Select the storage/printer/worklist/Q/R application and click OK. This setting applies to the
local workstation only.

With the Edit command you can edit only the AE’s that have been added with the Add
command.

Click the upper Setup button in the Applications window to check or change the settings
for the DICOM storage application. The DICOM Storage Setup window will appear.

Click the respective Setup button in the Applications window to check or change the
settings for the media storage application. The DICOM Storage Setup window will
appear.

Here you can define how or in which form the image pixel data will be sent. The option
Send Original (Raw) Image means that an unprocesessed image will be sent. Send
Processed Image means that a processed image will be sent. Original Image + Window
Center and Width means that the parameters for linear contrast enhancement will be sent
separately from the image data. Original Image + LUT (with gamma) means that a Lookup
Table for nonlinear contrast enhancement will be sent. Gamma correction will be applied
to the LUT.

You can also specify the storage SOP Class (service-object pair class). If the option
Secondary Capture Image Storage is selected, the images will be sent as Secondary
Capture Objects. Most DICOM PACS and Workstation products support only this option. If
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either of the Digital X-Ray Image Storage options is selected, the images will be sent as
Dental Image Objects as defined in Supplement 32 of the DICOM Standard.

The Storage Commitment selection enables you to decide whether to use storage
commitment. The storage commitment service class defines an application-level class-of-
service which facilitates this commitment to storage. See the DICOM Standard for details.

NOTE The “DICOM Storage Setup” settings are global. Nevertheless, they depend
on the selected Storage AE.

Click the respective Setup button in the Applications window to check or change the
settings for the DICOM printer application. The DICOM Printer Setup window will appear.
Refer to 7 “DICOM” on page 70 for information on this window and its contents.
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Click the lowest Setup button in the Applications window to check or change the settings
for the DICOM modality worklist. The message window shown below appears.

9.3.2 Devices

In the Devices window you can fill in the station name, model and serial number
(panoramic/cephalostatic and intraoral).

NOTE Settings for Devices apply to the local workstation only.
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9.3.3 Contact Information

In the Contact Information window you can fill in the institution name, address and the
department name.

NOTE Settings for Contact Information apply to the local workstation only, as
workstations may be situated in different departments and have different
addresses.
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10 MOVING IMAGES TO LONG TERM ARCHIVE
NOTE It is possible to prevent users from doing long term archiving. See page 127

for details.

After the exposure has been taken, and the image has been accepted, the image is stored
into the database located in the local PC or server. Because of the limited hard disk space
of the PC/server the system should be equipped with an external device to be used as a
long term archive, e.g. DVD drive.

To move an image to the long term archive, select the Move to Long Term Archive
command from the Administration pulldown menu that is visible when no images are
open.

The long term archive root directory must be specified before moving the images. If the
directory has not been specified, the following message window appears.

Move image(s) to
long time archive 
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To specify the long term archive root directory, first select the Local Settings command
from the Administration pulldown menu and then choose the Directories window. Click
the Browse button to locate the long term archive root directory.

Enter the requested date in the window that appears and click OK. All images that were
taken before and at the given date will be moved to the long term archive.
Alternatively, you can choose to move only the images of the current patient by selecting
that option and clicking OK.
Some of the patient’s images can be in the long term archive (LTA) while other images are
in the active database. New images can also be taken even if some of the images are in
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the LTA. Images can be restored at a future date. (Prior to Dimaxis 4.0.0, all the images
had to be either in the LTA or in the active database.)

NOTE You have to make a backup of the Solid database after you have moved the
images to the long term archive.

If the archive media is write protected, or not in position, the message window shown
below appears.

If no patients are found, or if the current patient does not have any images, the message
window shown below appears. Click OK to return to the Move Images to Long Term
Archive window.
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If the program finds patients who fulfill the criteria, the message window shown below
appears.
Continue by clicking Yes, or cancel the action by clicking No.

After the images have been moved, the message window shown below will appear. Click
OK.

NOTE IMPORTANT: If you use removable media as the long term archive, write the
Archive ID number on the media label.

NOTE The removable media is not secure, you must also do a backup from the
removable media to ensure the safety of the data.

NOTE Administrators have an additional possibility of archiving via the
PmLTArchiveSrv Gateway, which also allows scheduled (regular) archiving.
For more information, see APPENDIX F: “PmLTArchiveSrv GATEWAY” on
page 188.

After moving images to the long term archive, Dimaxis creates tif and log files in the
Temporary folder of Windows (C:\Documents and Settings\USERNAME\Local
Settings\Temp). The Dimaxis_LTA.log contains the current archiving information, such
as the patient names, the number of moved images, the archive folder, etc.
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NOTE You can also find the Temporary folder by giving the following command in
the Windows Explorer address bar: %temp%

In the image selection window, previews of moved images are displayed and a note In
Long Term Archive is shown above the preview. However, studies which have been
moved to the LTA can still be opened. The images of an open Study are also displayed as
previews with the appropriate note, see the figure below.

NOTE Images which have been moved to the long term archive with Dimaxis version
4.1.6 or older are displayed as a grey rectangle.
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11 STUDY TEMPLATES (OPTIONAL ONLY IN US)

11.1 Creating/Editing Study Templates

NOTE It is possible to prevent users from editing study templates. See page 127 for
details.

New templates can be created and the existing ones can be modified with the study
template editor.

The Study pulldown menu is visible when there are no images open. This menu can also
be opened before selecting a patient.

To create a new template select the New Template from the Study pulldown menu. The
New Study Template window appears. Enter the name of the new study and click Create.
The Study Template Editor window shown on page 167 appears.

To copy an existing template select Copy Template. The Select Study Template to be
Copied window appears. Select the desired template and click OK.

Create a new template

Delete selected template

Copy an existing template

Edit template

Hide/Unhide a study template
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The New Study Template window appears. Enter the name of the new study and click
Create.

If you did not change the template name the message window shown below appears.

To edit an existing template select Edit Template from the Study pulldown menu. The
Select a Study Template window appears. Select the desired template and click OK.
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The Study Template Editor window appears.

Modify the template according to the instructions given in this section and click OK to save
and close the window when the template is complete.
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11.1.1 Adding Image Placeholders

Select the image type by clicking the icon on the left side of the window. When you select
an Intracam, panoramic or cephalometric image, a placeholder for the image will appear
on the template. Move the placeholder to the desired position before selecting a new
image.

When you select an intraoral image, the Default Intra Image Parameters window
appears. Select the sensor orientation and sensor type.

Select the image print position from the grid in the Default Intra Image Parameters
window. The print position determines the image position in relation to the other images
when printing more than one image on one page. Refer to section 11.1.8 “Changing Image

Intraoral

Intracam

Panoramic

Cephalometric
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Placeholder Parameters” on page 173 for more information about selecting the print
position.

Click the Tooth Range button and select the teeth to be exposed in the window that
appears. Return to the Default Intra Image Parameters window by clicking OK.

Click OK in the Default Intra Image Parameters window and the placeholder for the
image will appear in the template. Move the placeholder to the desired position before
selecting a new image.

Print position 2/3
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11.1.2 Deleting Image Placeholders

You can delete an image placeholder with the Delete button on the left side of the window
after you have activated the placeholder with a mouseclick. Note that you can delete only
one placeholder at a time. Note also that you cannot delete a placeholder from a template
that is currently used in a study.

11.1.3 Aligning Images

To align the images on the template with one another select the desired images. Several
images can be selected by holding down the Ctrl key and then clicking the left mouse
button, or by clicking the right mouse button. Click the Align button and the Align Images
window appears.

The images can be aligned either along a horizontal line (tops, bottoms, top/bottom
centers) or along a vertical line (left sides, right sides, left/right centers).

11.1.4 Changing the Description

To change the description (name) of the template click the Description button. The Update
Study Template Description window appears.

Enter the template description and click OK.

Delete

Align

Description button
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11.1.5 Selecting Exposure Order

To select the exposure order of intraoral images click the Exp.Order button and then click
the image placeholders in desired exposure order. The exposure order number is shown
at the upper left corner of the placeholder.

11.1.6 Selecting DICOM Image Series

By default images from different modalities belong to different series.

Click the Series button and the Series Selection window appears.

To assign image placeholders to a DICOM image series select the desired series from the
list and click OK. You can also add new series to the list, delete existing series and modify
series descriptions.

The following message window appears. Click OK and click the desired image
placeholders. The series number is shown at the upper right corner of the placeholder. If
you wish to re-assign the placeholder back to its default series, first select the default
series for the placeholder from the list (i.e. select Panoramic for a panoramic placeholder)
and then click the placeholder.

Exposure Order button

Series button
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To add a new series click the New button. The New Series window appears. Fill in the
series number and description and click OK. Note that numbers 0-9 are reserved for the
default series and cannot be used.

To modify a series description select the desired series and click the Modify button. The
Modify Series Description window appears. Change the description and click OK.

If you try to modify series numbers 0-9, the message window shown below appears. Click
OK.

If you have modified the template and want to cancel the modifications, the message
window shown below appears.
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To delete a series select the desired series and click the Delete button. The message
window shown below appears. Click Yes to delete the series, or return to the Series
Selection window by clicking No.

If you try to delete the series numbers 0-9, the message window shown below appears.
Click OK.

11.1.7 Changing DICOM Send Order

By default the images will be sent to DICOM AE in the acquisition order. To change the
send order click the Send Order button and then click the image placeholders in desired
order. The DICOM send order number with text (DICOM) is shown below the placeholder.

11.1.8 Changing Image Placeholder Parameters

To change the image placeholder parameters select an image placeholder and click the
Parameters button, or double-click an image placeholder.

The intraoral image parameters are shown in the Default Intra Image Parameters
window. In this window you can change the tooth range, the sensor orientation and the
sensor type. You can also select the image print position from the grid in the window. The
print position determines the image position in relation to the other images when printing
more than one image on one page. The position of the current image is indicated with a
black square and the selected positions of the other images with grey squares. The print

Send Order button

Parameters button
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position is also indicated with row/column numbers at the lower right corner of the
placeholder.

NOTE The selected print order is used only if the print position has been specified
for all the images to be printed.

If you select a panoramic, cephalometric or Intracam placeholder and click the Parameters
button the Print Position window appears. You can select the image print position from
the grid in the window.

NOTE The selected print order is used only if the print position has been specified
for all the images to be printed.

Print position 2/3
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11.2 Hide/Unhide a Study Template

To hide or unhide an existing study template, select Hide/Unhide Template from the
Study pull down menu. The Hide/Unhide a Study Template window appears.

Select the template you want to hide and choose Hidden in the Visible Status box. The
template will no longer be visible and available in the Intraoral Exposure selection. Existing
studies which use a hidden template are hidden as well and are no longer visible in the
Image Selection.

11.3 Deleting a Study Template

To delete a study template select Delete Template from the Study pulldown menu. The
Select Study Template to be Deleted window appears.
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Select the study you want to delete and click OK. The message window shown below
appears. Click Yes to delete the template, or cancel the action by clicking the No button.

If you try to delete a template that is used in a study, the message window shown below
appears.
176  Dimaxis Pro/Classic User’s Manual



STUDY TEMPLATES (Optional only in US)
Dimaxis Pro/Classic 177User’s Manual



1

APPENDIX A: PMBRIDGE
PmBridge is a simple way for software companies to “bridge” their practice management
software with Planmeca Dimaxis.

In this integration model Dimaxis will handle all the image manipulation and viewing related
operations and user interactions. All the patient/practice data related operations (including
patient selection) and interactions are to be handled by the practice management software.
This system makes it very simple and quick for the practice management software house to
create this link or bridge to the Dimaxis.

PmBridge documentation for software developers can be found in the Dimaxis CD (under
folder “Support”).
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APPENDIX B: VDDS
The VDDS Bridge allows seamless integration to most German practice management
softwares. The VDDS Bridge interface application is available on the Planmeca Dimaxis Pro
installation CDs. See the Dimaxis Pro/Classic’s Installation manual for details.
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APPENDIX C: PLANMECA DICOM GATEWAY (Pro ver-
sion only)

The Planmeca DICOM Gateway is a program that automates some DICOM functions. The
Dimaxis installation program installs the program by default as a service. A log file
‘PmDcmGw_log.txt’ is created in the Dimaxis program folder when the service is started. The
gateway can be configured using the ‘DICOM Gateway Configure’ program to send the new
images automatically to the DICOM archive or to copy Worklists to the Dimaxis database.
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APPENDIX D: NAME CONVERTER
The NameConverter.exe is a new helper application for converting the patients’ names to the
same format (the first letter capitalized or all in upper-case letters).
It the patient data is received from several sources (for example different practice
management systems) there can be names formatted in different ways in the database.
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APPENDIX E: TESTER SOFTWARE FOR SOLID
The TestSolid.exe is a new helper application for checking the health of the Solid database.
The application shuts down the database, executes the command “solfe -x textblocks” and
shows the test report in a dialog. The check should be performed regularly.

If the Clear the log file feature is enabled, the file is saved under a different name and the
report of this check will not be shown again.

There should not be users with Dimaxis open when running this program.
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APPENDIX F: PmLTArchiveSrv GATEWAY
PmLTArchiveSrv is used as an additional possibility to archive images and patient information
in a long term archive. Administrators can use the PmLTArchiveSrv.exe by running it in the
Windows command prompt. It can be utilized as a ‘service process’ or as a stand alone LTA
‘one shot’ process. The database can thereby be selected via the system environment
variable or the DSN in the Dimaxis.ini file.

More detailed information for administrators can be found in the Dimaxis CD (under folder
“Support”.)
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